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1 Introduction

Thank you for choosing Qwizdom! This is a user guide for the Qwizdom Interactive
Learning System.  This guide provides information with tips and notes on using
Qwizdom.

If you need technical support, use the Troubleshoot section to identify and solve problems
related to Qwizdom Interact.  We also have interactive video tutorials on our website to
assist in using our program.  Contact Technical Support for further assistance.

Website www.qwizdom.com

Phone (253) 770-1285

E-mail support@qwizdom.com

Office Hours 6:00 a.m. to 4:30 p.m. PST

Address Qwizdom, Inc.
12617 Meridian East
Puyallup, WA  98373

2 Getting Started

Contents of Remote Set
Q4 RF or Q5 RF Student/Participant Remotes
1 RF Host
1 Q5 Instructor Remote
1 USB Cable
1 Charger for Q5 Instructor Remote
1 Multi-charger for Q5 Student Remotes (if applicable)
1 Screwdriver
AA Batteries
1 Remote Carrying Case
1 Quick Reference Guide*
1 Software; Qwizdom Interact for Windows
*Full user guide is located on the disc on our website.

2.1 Installing Software

System Requirements
Windows 98/00/ME/XP
800 MHz Pentium III and later
128 MB RAM (256 MB recommended)

http://www.qwizdom.com/video_tutorials.php
http://www.qwizdom.com/index2.php
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Hard drive with 100 MB free space
16 bit color display
CD-ROM drive
Powered USB Port
Microsoft PowerPoint 2000 or later (for importing PowerPoint slides)

Before installing your new software, exit all applications.  You may need to have
administrator level access in order to install your software. Software updates are available
on Qwizdom's Web site and can only be applied to computers with existing Qwizdom
Interact.

Windows 98/2000/NT/XP/Vista
1. Insert your Qwizdom Interact into the CD-ROM drive.
2. The Interact Install window will appear.  Click on the Install Interact button
3. The Qwizdom Interact-InstallShield wizard will appear.  Click Next.
4. Click on the Install button.  The License Agreement appears.  Please read the

Qwizdom, Inc. License Agreement and select "I do accept the terms of the license
agreement."

5. Click on Next to install software.  This will take a few moments.
6. Once the installation is complete, restart your computer if prompted to do so.
7. Double-click on the Qwizdom Interact icon on your desktop to launch the program.

You will be prompted to register your software.  The product code used to register
the software is located on the back of the software case.

NOTE:  If a "Bad Media I/O Error" prompt appears when installing Qwizdom software
or if the software fails during installation, the disc may be defective.  Contact Tech
Support for assistance.

Installing Curriculum
Qwizdom Interact must be installed first before installing curriculum.

1. Insert the curriculum disc into the CD-ROM drive.  The Interact Install window will
appear.

2. Click on the Install Curriculum button.
3. Enter the curriculum product code.  Entering the product code here is for the

program to know which software to install.  This is not registration.  You register
the curriculum within the program.  The Installation Type windows will appear.

4. Click on Stand-Alone Installation.  The curriculum will begin to install.  This will take
a few moments.

5. When the installation is complete, double-click on the Qwizdom Interact icon on
your desktop to launch the program.  A New Activities Detected window will
appear.

6. Check the units you want imported into Qwizdom Interact.  Each unit may take 2-5
minutes.

7. After all the units have imported, you will need to register your curriculum.

http://www.qwizdom.com/index2.php
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8. Go to the Help menu and select Register Content.
9. Type in the product key and click Add, then Done to register your content.

2.2 Hardware Setup

1. Plug the USB cable into the RF Host and then plug the other end of the USB cable
into an open USB port.

2. Place two AA batteries (provided in the remote set) and insert the screw (optional)
into the back of the Q4 RF remote to secure the battery compartment.  Plug the Q5
RF student and Q5 RF instructor remotes into the multi-charger and/or single
charger for 24 hours before first use.

Installing USB Drivers on Vista
You will need to do this procedure twice (because there are two drivers).

1. Insert the Qwizdom Interact disc into the computer and make sure the host is
plugged in properly.

2. From the Start menu, go to the Control Panel.
3. Click on Hardware and Sound.
4. Click on  Device Manager.
5. Select the option View Devices by Type under the View menu.
6. Qwizdom RF Host should be located under Universal Serial Bus Controllers, Ports and

Unknown or Other Devices.
7. When you find it, double-click on it and click on the Driver tab.
8. Click on the button that says Update Driver.  The installation wizard will appear.
9. Select "Browse Computer for Software Driver" and click Next.
10. Click on the Browse button.  A window appears.
11. Click on My Computer, click on the drive that Interact is in, and then find the folder

that says USB_Drivers.
12. Click OK and then Next.
13. When it's done installing, click on Close.  Repeat the above steps once more and

then restart your computer.

Installing USB Drivers on Windows 2000/XP
You will need to do this procedure twice (because there are two drivers).

1. Insert the Qwizdom Interact disc into the computer and make sure the host is
plugged in properly.

2. From the Start menu, go to the Control Panel or go to Settings and then Control
Panel.

3. Double-click on the System icon and click on the Hardware tab.
4. Click on the Device Manager button.
5. Select the option View Devices by Type under the View menu.
6. Qwizdom RF Host or Qwizdom USB Base should be located under Universal Serial Bus
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Controllers, Ports and Unknown or Other Devices.
7. When you find it, double-click on it and click on the Driver tab.
8. Click on the button that says Update Driver.  The installation wizard will appear.
9. Select "Install from a list or specific location" and click Next.
10. Select "Search for the best driver in these locations" and check the "Search removable

media" and "Include this location in search" boxes.
11. Click on the Browse button, click on My Computer, click on the drive that Interact is

in, and then find the folder that says USB_Drivers. (Do not open the folder).
12. Click OK and then Next.  A prompt will appear that says the drivers have not passed

the Microsoft Windows Update testing, click on Continue Anyway and then Finish.
13. Repeat the above steps once more and then restart your computer.

Installing USB Drivers on Windows 98
You will need to do this procedure twice (because there are two drivers).

1. Insert the Qwizdom Interact disc into the computer and make sure the host is
plugged in properly.

2. From the Start menu, go to Settings.
3. Go to the Control Panel and double-click on the System icon.
4. Click on the Device Manager tab.
5. Select the option View Devices by Type.
6. Qwizdom RF Host or Qwizdom USB Base should be located under Universal Serial Bus

Controllers, Ports and Unknown or Other Devices.
7. When you find it, select the file and then click on the Properties button on the

bottom.
8. Click on the Driver tab and click on the button that says Update Driver.  The

installation wizard will appear.
9. Click Next and select "search for a better driver than the one your device is using now."
10. Click Next.
11. Check the CD-ROM drive and Specify Location.
12. Click on the Browse button.  Go to the drive the Interact disc is in and then select

the USB_Drivers.
13. Click OK and then Next.  A prompt will appear that says the drivers have not passed

the Microsoft Windows Update testing.
14. Click on Continue Anyway and then Finish.
15. Repeat the above steps once more and then restart your computer.
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3 Chapter 1

3.1 Folders

Folders organize activities in the content tree.

1. Click on the  New Folder button.
2. Enter the folder name and click OK.
3. The folder will appear in the content tree on the left side of the screen.  The folder

is automatically saved in the content tree and is marked by a folder icon.

TIP:  To rearrange activities or folders, simply click, drag, and drop the activity or
folder in the desired location.

Renaming a Folder
1. Select the folder you want to rename in the content tree.
2. Double-click on the name of the folder.  A box will appear around the name.
3. You are now able to change or revise the name of the folder.

Deleting a Folder
1. In the content tree, select the folder you would like to delete.
2. Go to the File menu and select Delete Folder and Contents.
3. The folder is deleted and removed from the content tree.

3.2 Activities

Activities are composed of slides and are presented as lessons, tests, games, etc.

1. Select a folder you want the activity to appear in (optional).

2. Click on the  New Activity button.
3. Enter the activity name and click OK.
4. The activity will appear in the content tree.  The activity is automatically saved in

the content tree.

TIP:  To rearrange activities or folders, simply click, drag, and drop the activity or
folder in the desired location.

Renaming an Activity
1. Select the activity you want to rename in the content tree.
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2. Double-click on the activity.  The Activity Properties window will appear.
3. Under the Generic Properties tab, change or revise the name of the activity in the

Name box.
4. Click on Done when finished.

Duplicating An Activity
1. Select an activity in the content tree you want to duplicate.
2. Go to the File menu and select Duplicate As.
3. Enter the new name of the duplicated activity and click on OK.
4. The duplicated activity will appear in the content tree.

Deleting an Activity
1. In the content tree, select the activity you would like to delete.
2. Go to the File menu and select Delete Activity.
3. The activity is deleted and removed from the content tree.

Restoring a Deleted Activity
1. Double-click on the My Computer icon on your desktop.
2. Double-click on the C Drive.
3. Double-click on the Program Files folder.
4. Double-click on the Qwizdom folder.
5. Double-click on the Qwizdom Interact folder.
6. Double-click on the Activities folder.
7. Double-click on the Deleted Activities folder.
8. Select the deleted activity and right click on it.
9. Select Copy and go to your desktop.
10. Right click on the desktop and select Paste to copy the deleted activity onto the

desktop.
11. Open Qwizdom Interact and go to the File menu.
12. Select Import Activity or Archive. The Open window appears.
13. Change the "Files of Type" to .qwz.
14. Direct the location to the desktop and select the deleted activity (.qwz).
15. Click on Open and the activity will import back into the program.

3.3 Slide Editor

Slide Editor is where you create and edit slides.  Here is a quick overview on the Slide Editor
functions and items.
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Edit Menu

-cut/deletes object -equation editor
-copy object -create a straight line
-paste object -create a single arrow
-delete object -create a double-head arrow
-spell check -create a rectangle
-insert image -create a filled rectangle
-insert multimedia (movie, sound) -create a circle
-insert text -create a filled circle

Font Menu

-font selector -converts font to uppercase

-font size selector -superscript
-normal font -subscript
-bolds font -color palette to change font

and object color
-changes font to italics -center justify paragraph
-underlines font -right justify paragraph
-converts font to lowercase -full justify paragraph

History Window
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The history window is the undo feature.
-redo all
-redo
-undo
-undo all
-clear history

Slide Properties

· Type-select the type of slide; i.e. multiple choice, true/false, short answer, etc.
· Difficulty-slide difficulty can be set as Simple, Intermediate, Advanced, and Expert.
· Time Limit-the time limit can be set on every slide; you want to give an ample

amount of response time (in seconds only, not minutes) for students.
· Points-each slide can be assigned a number of points
· Layout-choose from many templates (image w/text, text only, images w/headline)

Printing/Narration Properties
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Narration is a special order feature.  To order Narration, please contact 1-800-347-3050.  For
more information on narration, see Narration.

· Information on the slide will be displayed under the Question section; click on
Customize to edit the text.

· Answer choices will be displayed under the Answer section; click on Customize to
edit the text.

· Click on the  to have the slide read aloud by the computer narrator; click on
Customize to edit the text.

Media Search

Type in the keyword(s) for image and multimedia files.  You can also add keywords to the
image and multimedia search.
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Answer Menu

After creating a question slide, you will select the answer to the question.  The answer
menu is where you select the correct answer(s) and is located under the Properties tab.
Once you select the correct answer(s), an answer slide is automatically generated after the
question slide.  The correct answer(s) will be highlighted by an asterisk.

Quick Creator Menu

The Quick Creator menu is located in the bottom right corner of the Slide Editor.  You can
click on the New Q button to open a new slide set without exiting the Slide Editor.

-insert/adds slides in slide set -create new question slide

-delete slide -go back to previous question

-generate answer slide -go to next question

3.4 Slides

Slides display information, images, sound, and animations for presentation purposes.

Information

1. Click on the  New Set button.  The Slide Editor opens.
2. In the Properties tab, select Information as the slide type.
3. Select a template in the Layout.
4. Enter text onto the slide; adding multimedia such as images, movies, sound are

optional.
5. When the slide is complete, either go to File menu and select Close; or click on the

 New Q button to open a new slide set.

TIP:  You can rearrange slides in an activity simply by clicking and dragging the slides
from left to right while in the Content screen.
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True/False

1. Click on the  New Set button.  The Slide Editor opens.
2. In the Properties tab, select  True/False as the question type.
3. Setting the difficulty level, time limit, and number of points are optional.
4. Select a template in the Layout.
5. Enter text onto the slide; adding multimedia such as images, movies, sound are

optional.
6. Select the correct answer in the Answer Menu  to generate the answer slide.

7. When the slide is complete, either go to File and select Close; or click on the 
New Q button to create a new slide set.

Yes/No

1. Click on the  New Set button.  The Slide Editor opens.
2. In the Properties tab, select  Yes/No as the question type.
3. Setting the difficulty level, time limit, and number of points are optional.
4. Select a template in the Layout.
5. Enter text onto the slide; adding multimedia such as images, movies, sound are

optional.
6. Select the correct answer in the Answer Menu  to generate the answer slide.

7. When the slide is complete, either go to File and select Close; or click on the 
New Q button to create a new slide set.

Creating a Multiple Choice Slide

1. Click on the  New Set button.  The Slide Editor opens.
2. In the Properties tab, select  Multiple Choice as the question type and the number of

choices.
3. Setting the difficulty level, time limit, and number of points are optional.
4. Select a template in the Layout.
5. Enter text onto the slide; adding multimedia such as images, movies, sound are

optional.
6. Select the correct answer in the Answer Menu  to generate the answer slide.

7. When the slide is complete, either go to File and select Close; or click on the 
New Q button to create a new slide set.

Multiple Mark
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This question type enables two or more correct answers.

1. Click on the  New Set button.  The Slide Editor opens.
2. In the Properties tab, select  Multiple Mark as the question type and the number of

options.
3. Setting the difficulty level, time limit, and number of points are optional.
4. Select a template in the Layout.
5. Enter text onto the slide; adding multimedia such as images, movies, sound are

optional.
6. Select the correct answers in the Answer Menu  to generate the answer slide.

7. When the slide is complete, either go to File and select Close; or click on the 
New Q button to create a new slide set.

Numeric

1. Click on the  New Set button.  The Slide Editor opens.
2. In the Properties tab, select  Numeric as the question type.
3. Setting the difficulty level, time limit, and number of points are optional.
4. Select a template in the Layout.
5. Enter text onto the slide; adding multimedia such as images, movies, sound are

optional.
6. Uncheck the "No Answer (Survey)" box and enter a correct answer.

7. Click on the  Generate Answer button in the lower right to generate the answer
slide.

8. When the slide is complete, either go to File and select Close; or click on the 
New Q button to create a new slide set.

Sequence
Place item choices in the specified order.

1. Click on the  New Set button.  The Slide Editor opens.
2. In the Properties tab, select  Sequence as the question type and the number of

items.
3. Setting the difficulty level, time limit, and number of points are optional.
4. Select a template in the Layout.
5. Enter text onto the slide; adding multimedia such as images, movies, sound are

optional.
6. Uncheck the "No Answer (Survey)" box and enter a correct answer.
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7. Click on the  Generate Answer button in the lower right to generate the answer
slide.

8. When the slide is complete, either go to File and select Close; or click on the 
New Q button to create a new slide set.

Multiple Answer List (non-remote)
This question type enables two or more correct answers.

1. Click on the  New Set button.  The Slide Editor opens.
2. In the Properties tab, select  Multiple Answer List as the question type and the

number of options; selecting this question type automatically generates the
answer slide.

3. Setting the difficulty level, time limit, and number of points are optional.
4. Select a template in the Layout.
5. Enter text onto the slide; adding multimedia such as images, movies, sound are

optional.
6. Select the required number of options.

7. When the slide is complete, either go to File and select Close; or click on the 
New Q button to create a new slide set.

Fill In/Completion (only applicable to Q5 RF remotes)
This question type allows correct answer(s) up to 30 characters.

1. Click on the  New Set button.  The Slide Editor opens.
2. In the Properties tab, select  Fill In/Completion as the question type.
3. Setting the difficulty level, time limit, and number of points are optional.
4. Select a template in the Layout.
5. Enter text onto the slide; adding multimedia such as images, movies, sound are

optional.

6. Enter the correct answer and click on the  Generate Answer button in the lower
right to generate the answer slide.

7. A prompt will appear asking if you would like to replace the existing answer slide.
Click on Yes.

8. When the slide is complete, either go to File and select Close; or click on the 
New Q button to create a new slide set.

Short Answer Specific (only applicable to Q5 RF remotes)
This question type allows correct answer(s) up to 30 characters.
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1. Click on the  New Set button.  The Slide Editor opens.
2. In the Properties tab, select  Short Answer as the question type.
3. Setting the difficulty level, time limit, and number of points are optional.
4. Select a template in the Layout.
5. Enter text onto the slide; adding multimedia such as images, movies, sound are

optional.

6. Enter the correct answer and click on the  Generate Answer button in the lower
right to generate the answer slide.

7. A prompt will appear asking if you would like to replace the existing answer slide.
Click on Yes.

8. When the slide is complete, either go to File and select Close; or click on the 
New Q button to create a new slide set.

Essay (non-remote)

1. Click on the  New Set button.  The Slide Editor opens.
2. In the Properties tab, select  Essay as the question type.
3. Setting the difficulty level, time limit, and number of points are optional.
4. Select a template in the Layout.
5. Enter text onto the slide; adding multimedia such as images, movies, sound are

optional.

6. When the slide is complete, either go to File and select Close; or click on the 
New Q button to create a new slide set.

Rating Scale

1. Click on the  New Set button.  The Slide Editor opens.
2. In the Properties tab, select  Rating Scale as the question type.
3. Setting the difficulty level, time limit, and number of points are optional.
4. Select a template in the Layout.
5. Enter text onto the slide; adding multimedia such as images, movies, sound are

optional.
6. Select the range in the Rating Scale area.

7. When the slide is complete, either go to File and select Close; or click on the 
New Q button to create a new slide set.

Survey
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1. Click on the  New Set button.  The Slide Editor opens.
2. In the Properties tab, select a remote answerable question type such as Multiple

Choice, True/False, Yes/No, etc.
3. Select a template in the Layout.
4. Enter text onto the slide; adding multimedia such as images, movies, sound are

optional.
5. Select "None" or "No Answer [Survey]" (depends on question type).

6. When the slide is complete, either go to File and select Close; or click on the 
New Q button to create a new slide set.

3.5 Equation Editor

Equations can be created using the Equation Editor within Qwizdom Interact.  Equation
Editor has a help guide that you can access from the Help menu in the Equation Editor
window.

Creating an Equation

1. Click on the  New Set button.  The Slide Editor opens.
2. Under Type in the Properties tab, select the type of slide you are wanting to create

(Numeric, Multiple Choice, etc.) and select a layout.
3. There are two ways to insert an equation onto the slide-click on the  Equation

button in the toolbar OR go to the Text menu and select Create Equation to activate
Equation Editor.  You will notice your mouse cursor will change into a plus sign.

4. Move the cursor so that it's on the slide and click the mouse.  A text box will appear
and the Equation Editor window will open.

5. Click on a button that has the equation template you want to use and select the
template.  The template will appear in the Equation Editor window.

6. Create the equation.
7. When finished, go to File and select Exit and Return to Qwizdom Interact.  You will

be taken back to the Slide Editor screen and the equation will appear on the slide.
8. If the equation is too small or large, resize the equation to the desired size.  Read

Resizing Equations below for more information.

Inserting an Equation in the Line of Text

1. Click on the  New Set button.  The Slide Editor opens.
2. Under Type in the Properties tab, select the type of slide you are wanting to create

(Numeric, Multiple Choice, etc.) and select a layout with a text template OR click on
the  Text button to create a text box.
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3. Place the cursor over a text box.  There are two ways to place an equation in the
line of text-right-click the mouse and select Equation OR go to the Text menu and
select Insert Equation.  The Equation Editor window will appear.

4. Click on a button that has the equation template you want to use and select the
template.  The template will appear in the Equation Editor window.

5. Create the equation.
6. When complete, go to File and select Exit and Return to Qwizdom Interact.  You will

be taken back to the Slide Editor screen and the equation will appear in the text
box on the slide.

7. If the equation is too small or large, resize the equation to the desired size.  Read
Resizing Equations below for more information.

Editing an Equation
1. Double-click on the equation on the slide.  The Equation Editor window opens.
2. Edit the equation.
3. When you are finished, go to File and select Update and then select Exit and Return

to Qwizdom Interact.

Changing the Equation Editor Font Size
1. Double-click on the equation on the slide.  The Equation Editor window opens.
2. Go to the Size menu and select Define.  The Sizes window will appear.
3. In the Full box, type in the number for the preferred font size.  A font size of 50-80

works best.  Usually font sizes in this range do not need to be resized on the slide.
4. Click Apply and then Okay.  You will be taken back to the Equation Editor window.
5. Highlight the equation, go to the Sizes menu, and select Full.  The font size will

change to the size you set it as.
6. Go to File and select Exit and Return to Qwizdom Interact.

Resizing Equations
1. Double-click on a slide with an equation on it.  The Slide Editor will open.
2. Left click once on the equation and you will see black handles flash on the inside of

the equation box (not the white handles, white handles are for the text box and
will not resize the equation).

3. Move the mouse over to where you saw one of the black handles.  When the
cursor is over one of the black handles, your cursor will change into a double-
headed arrow.

4. Click on the black handles and drag with the mouse to resize the equation to the
desired size.  This can be tricky at first, but once you get it down, it will become
easier.
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3.6 Multimedia

Images
There are three different ways to add images:

· Click on the  Image icon on the slide.
· Go to Graphics menu and select Set Image.
· Click on the  Image button in the toolbar.

1. Click on the  New Set button.  The Slide Editor opens.
2. Under Type in the Properties tab, select the type of slide you want to create

(Information, Multiple Choice, etc.).
3. Select a layout that has a multimedia template.  Multimedia templates have blue

squares/rectangles in the layout.

4. Click on the  Image icon on the slide and the Open window will appear.
5. Search for the image you want to use and select it.
6. Click on Open.  The image will appear on the slide. You can resize the image by

clicking and dragging on one of the handles around the image.
7. Add text or color to the slide (optional).
8. When finished, go to the File menu and select Close.

Sound
There are three ways to add sound:

· Click on the  Multimedia icon on the slide
· Go to the Graphics menu and select Add Multimedia
· Click on the  Multimedia icon in the toolbar

1. Click on the  New Set button.  The Slide Editor opens.
2. Under Type in the Properties tab, select the type of slide you want to create

(Information, Multiple Choice, etc.).
3. Select the layout that has a multimedia template.  Multimedia templates have blue

squares/rectangles in the layout.

4. Click on the  Multimedia icon on the slide and the Open window will appear.
5. Search for the sound file you want to add.  You may need to change the file type in

the Files of Type drop-down menu to view the file you're searching for.
6. When you find the sound file you want to add to the slide, select it and click on

Open.  The  Sound button will appear on the right side of the slide indicating
there is a sound file on the slide.

NOTE:  To remove a sound file from the slide, click on the sound icon and press the
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Delete key on your keyboard.

7. Click on the  Sound button drop-down menu, located in the right corner of
the slide.

8. Select Properties.  The Multimedia Options window will appear.
9. Check options such as Play when clicked, Repeat, Play automatically, and any other

options you prefer.  The checked options turn on during presentation.
10. Click OK to exit the Multimedia Options window.

11. To play the sound, click on the  Sound button drop-down menu and select
Play/Stop.

12. When finished, go to File and select Close.

Video
There are three ways to add video:

· Click on the  Multimedia icon on the slide
· Go to the Graphics menu and select Add Multimedia
· Click on the  Multimedia icon in the toolbar

1. Click on the  New Set button.  The Slide Editor opens.
2. Under Type in the Properties tab, select the type of slide you want to create

(Information, Multiple Choice, etc.).
3. Select the layout that has a multimedia template.  Multimedia templates have blue

squares/rectangles in the layout.

4. Click on the  Multimedia icon on the slide and the Open window will appear.
5. Search for the movie you want to add.  You may need to change the file type in the

Files of Type drop-down menu to the specific movie file you're searching for.
6. When you find the movie file you want to add to the slide, select it and click on

Open.  The movie should display on the slide and the  Multimedia icon will
appear on the right side of the slide indicating that there is a movie on the slide.

7. Click on the  Multimedia drop-down menu and select Properties.  The
Multimedia Options window will appear.

8. Check options such as Repeat, Visible in presentation, Play automatically, and any
other options you prefer.  The checked options turn on during presentation.

9. Click OK to exit the Multimedia Options window.
10. To play the movie, double-click the movie, to stop it, click on the red X.
11. When finished, go to File and select Close.

Multimedia Search
1. Click on the Media tab in the Slide Editor window.
2. Type in a keyword and click on Search.  If any images or multimedia files match the

keyword, the files will appear in the Media tab window.
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3. Click and drag the desired file and drop it onto the slide.  If you drop an image file
onto the slide, you may have to adjust/resize the image.

3.7 Standards

Select any activity you would like to link standards to.
1. Select an activity that the standards will be linked to.

2. Click on the  Standards button.  The Standards window will appear.
3. In the Current Standard drop-down list, select the standards for your state.
4. Select the standards you would like to apply and click on Add.
5. Select either standards applied to the whole activity or to selected slides.  To delete

individual standards that do not apply to the activity, highlight the standard and
hit the Remove button.  Clicking on the Remove button will delete all standards.

6. Click Done when complete.
7. To view the applied standards, go to the View menu and select Properties.  The

Properties tab will appear at the bottom of the Content screen.
8. Click on the Standards tab.  All of the standards that have been applied to that

particular activity/slide will display.
9. Go to the View menu and uncheck the Properties option to hide the Properties

window.

3.8 Creating Game Activities

Almost any activity can be used as a game.  There are a couple requirements to use an
activity (you create or pre-existing) as a game.

· Activities should contain 25 slides or more.
· Slides in the activities must be remote answerable question types such as

Multiple Choice, True/False, Yes/No, Numeric, or Short Answer-Specific (Q5
RF remotes only).

· Each slide set must have a question and answer slide.

Presenting an Activity as a Game
When you present an activity as a game, the activity temporarily converts into a game for

that presentation only.
1. Select an activity in the content tree.  The activity must consist of 25 slide or more.

There slides must be remote answerable (Multiple Choice, True/False, etc.) and have
an answer slide.
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2. Click on the  Present button.  The Presentation Setup window will open.
3. Select the class you want to present the game to.
4. Click on the Play Mode drop-down menu and select Game.
5. Click on the Game drop-down menu and select the game type.
6. If groups are required to play the game, select "Use Groups."  See Group Setup for

information on creating groups.  Certain games require you to play in group mode
or limits the number of players so you may need to play in groups.  See Games for
player limitation and group mode play.

7. Click OK to begin the game.  The host will initialize and the game setup screen will
appear.  The only game that doesn't have a setup screen is K-Bowl.

8. Select the options in the game setup screen and click on >> or Continue to begin
the game.  See Games for directions on playing a game.

Creating a Quandary Activity
Quandary activities must consist of 25 slides and 5 topics in order to fill the game board.

1. Click on the New Activity button.
2. Type the activity name and click OK.
3. Click on the New Set button.  The Slide Editor will open.
4. Create 25 question and answer slides (five slides for each of the five categories).

Only remote answerable slides are allowed (Multiple Choice, True/False, etc.).
Every question must have an answer slide.

5. When all 25 slides have been created, go to the Edit menu and select Edit Quandary
Topics.  The Edit Quandary Topics window appears.

6. Type in the topic names.  Topic 1 will apply to the first 5 slides, topic 2 will apply to
the next 5 slides, and so on.

7. Click on OK when done.
8. Click on the Present button to present the activity.  The Presentation Setup window

appears.
9. In the 1 General Options area, select Game as the Play Mode and Quandary as the

Game.
10. Select the class and check the desired options.
11. When the setup is complete, click OK and the presentation will begin.

Creating a Quandary Activity from Existing Activities
1. Click on the New Activity button.
2. Type the activity name and click OK.
3. What you're going to do is copy and paste slides (a total of 25 slides) from other

activities into this activity to create a Quandary game.
4. Select an activity in the content tree.  There are two ways to copy slides.  Either you

can select the slides, go to the Edit menu and select Copy or drag and drop the
selected slides into the activity (in the content tree).
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5. Copy 25 slides into the activity (that will be presented as Quandary).
6. Once you have 25 slides in the activity, go to the Edit menu and select Edit

Quandary Topics.  The Edit Quandary Topics window appears.
7. Type in the topic names.  Topic 1 will apply to the first 5 slides, topic 2 will apply to

the next 5 slides, and so on.
8. Click on OK when done.
9. Click on the Present button to present the activity.  The Presentation Setup window

appears.
10. Depending on the version of the software-in the 1 General Options area, select

Game as the Play Mode and Quandary as the Game or select the game under the
Game Type drop-down menu in the Game Options area.

11. Select the class and check the desired options.
12. When the setup is complete, click OK and the presentation will begin.

3.9 Importing and Exporting

Exporting Qwizdom Interact Activities
1. Select the activity you would like to export.
2. Go to the File menu and select Export Activity.  The Export Content window will

appear.

3. Click on the  (browse) to change the path to the desired location of where you
would like to export the activity.

4. Click Export and the activity will be exported to the directed location.  The activity
will be saved as a .qza file format.

Exporting Qwizdom Interact Folders
1. Select the folder you would like to export.
2. Go to the File menu and select Export Folder.  The Export Content window will

appear.

3. Click on the  (browse) to change the path to the desired location of where you
would like to export the activity.

4. Click Export and the folder will be exported to the directed location.  The folder will
be saved as a .qza file format (all activities within the folder will be compressed into
one single file).

Importing Qwizdom Interact Activities
1. Go to the File menu and select Import Activity or Archive (qza).  The Open window

will appear.
2. Search for the activity (it will be in qza. file format).  Answer key activities will be in

.key file format.
3. Select the activity and click Open.  The activity will import into the content tree.
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Importing Qwizdom Interact Folders
1. Go to the File menu and select Import Activity or Archive (qza).  The Open window

will appear.
2. Search for the folder (it will be in qza. file format) you would like to import.
3. Select the folder and click Open.  The folder will import into the content tree.

Importing Qwizdom TA Resources
1. Go to File and select Import TA Resource.  The Open window will appear.
2. Go to the C Drive and double click on the Program Files folder.
3. Double-click on the Qwizdom folder and double click on the Qwizdom TA folder.
4. Double-click on the name of the resource and select the .CTL file.
5. Click on Open. The TA resource will import into Qwizdom Interact.

Importing PowerPoint Slides
Microsoft PowerPoint slides import into Qwizdom Interact as objects (.jpeg image).  The
slides are set as information regardless of the original format.

1. Go to the File menu and select Import, then PowerPoint Slides.  An Open window
will appear.

2. Search for a PowerPoint file that you would like to import.  It will be in .ppt file
format.

NOTE:  Microsoft PowerPoint files that are imported into Qwizdom Interact cannot
have symbols in the file name (e.g. -.?/#@!$).

3. Select the PowerPoint file and click on Open.  The slides will import into Qwizdom
Interact.  Microsoft PowerPoint slides import into Qwizdom Interact as objects (.jpeg
format).  All the slides will be information slides.  You will need to edit each slide to
set it to the correct question format in order to use remotes for the imported
Microsoft PowerPoint activity.

If you import question and answer slides, the program doesn't know to put the matching
answer slide with the question slide.  In the Content screen, you will see how the slides
import.  You will see the question slide and then you will probably see the answer for it on
the next slide.  The question and answer slides need to be in one slide set, not separated in
different slide sets.  You will need to copy the answer slide into the slide set that has the
question slide.

1. Double-click on the imported Microsoft PowerPoint slide.
2. Under Type, select a question type such as Multiple Choice, Yes/No, True/False, etc.
3. Select the correct answer and an answer slide will generate.  You will notice that

the answer slide is blank.  This is because the Microsoft PowerPoint slide came in as
an object (image) on the slide.

NOTE:  If you need to edit information on the Microsoft PowerPoint slide, you will
need to open the original Microsoft PowerPoint file and reimport it into Qwizdom
Interact.

4. The corresponding answer slide is probably in another slide set.  If you want that
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answer slide with the question slide, click on the  Next Q button to go to the
next slide.  You will see the answer slide that goes with the question on the
previous slide set.

5. Go to Edit and choose Select All.
6. Go back to Edit and select Copy.

7. Now click on  Prev Q to go back to the last slide set.  The previous slide set will
appear with the question slide.

8. Click on the answer slide thumbnail on the bottom right of the screen.  The answer
slide will show.

9. Go to the Edit menu and select Paste.  The answer (image) will paste into the
answer slide.

10. You will need to do this with every imported Microsoft PowerPoint question and
answers slides.

Importing ExamView (.XML)
ExamView files must be saved as .XML files to import into Qwizdom Interact.  ExamView files
import into Qwizdom Interact as answer keys only (answer slides only).

1. Go to the File menu and select Import, then ExamView XML File.  An Open window
will appear.

2. Search for an ExamView file you would like to import.  It will be in .XML file format.
3. Select the ExamView .XML file and click Open.  The ExamView answers will then

import into Qwizdom Interact as an answer key only.

3.10 Printing

There are activities that require printing and passing them out to students.  For answer key
activities, students will work from their papers and respond in with their remotes.

1. Select the activity you would like to print.

2. Click on the  Print button or go to the File menu and select Print.  The
Qwizdom Interact Printing window will open.  A preview will generate and a
thumbnail view of the activity will be displayed with the following options below.

· Show Name Line-name, class, and date will appear at the top of the page
· Header/Footer-the header is the title of the printed material and can be

changed.  The footer is the activity name and cannot be changed.
· Questions Per Page-set the number of thumbnail slides you would like to

print on a single page

3. Click on the  Print button to print the activity.



26

Qwizdom, Inc. 2007

3.11 Narration

Narration ("Laura and Aaron" voices) is a special order feature.  To order Narration, please
contact 1-800-347-3050.

1. Click on the  New Set button.  The Slide Editor will open.
2. Go to the Edit menu and select Speech Options.  The Speech Options window will

appear.
3. Select the narrator and adjust his or her voice as you like.
4. When you are done, click on OK to take you back to the Slide Editor.
5. Go to the File menu and select Close to go to the Content screen.

Customizing Narration
1. Double-click on a slide you want to customize narration for.  The Slide Editor will

open.
2. Click on the Printing/Narration tab.
3. Click on the  Sound button to hear how the narrator will read the slide.
4. If you want to alter the way she reads the slide (pronouncing words, pausing in

between words/choices), go down to the Narration for Current Screen and check
the Customize box.

5. When finished, go to the File menu and select Close.  You will be taken back to the
Content screen.

6. Click on the Present button.  The Presentation Setup window will appear.
7. To activate the narrator for the presentation, check the Narrate Slides box under

Play Options.
8. Check the preferred options and select the class.
9. Click Okay when finished.
10.  The presentation will begin and the narrator will begin reading the slide.

Recording Narration
Narration can be created and added to the slides.  A microphone is needed to record your
own narration.

1. Select an activity that you would like to add narration to.
2. Go to the Edit menu and select Record Narration.  The recorder will appear.
3. Click on the record button (red circle) to record the narration.  The timer will start

and the play button (triangle) will turn into the stop button (square).
4. When you are done recording the narration, click on the stop button (square).

NOTE:  If you want to add more to the narration, click on the Record button (red
circle) to continue recording.  After the file is saved as a sound file, you cannot add or
edit the original file.

Applying Narration
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1. Select a slide in the activity you want to apply the narration to.
2. Now go to the Edit menu.  You will see these options:

· Save Narration-saves the narration to insert at a later time.
· Save and Add Narration to Selected Slide-saves the file and inserts the

narration to a selected slide.  You must first select a slide before you choose
this option.

· Cancel Narration-closes the recording window without saving.
3. Select Save and Add Narration to Selected Slide.  If this option is grayed out, it is

because you need to select a slide (a selected slide will be highlighted with a
yellow outline around the slide).

4. Double-click on the slide you added the narration to.  Slide Editor will open.  You
will see the sound icon in the upper right corner of the slide, indicating a sound file
has been inserted.

4 Chapter 2

4.1 Class Setup

Classes are created to organize and track students and are necessary in running a
presentation.

Creating a Class
1. In Qwizdom Interact, click on the Students tab.
2. Go to Class and select New Class.  The Class Information window will appear.
3. Type in the name of the class.
4. Select Normal in the Type drop-down menu.  You may include and fill in any other

information.
5. Click on Done and you will be taken back to the Students screen.  Go to Students to

learn how to add students to the class.

Anonymous Class
Anonymous classes allows the program to take the responses from unassigned remotes.
The anonymous option tells the programs to read the number of remotes in the class (e.g.,



28

Qwizdom, Inc. 2007

if you have 32 remotes in class, it will read remotes #1-32 to be in use for presentation).

1. In Qwizdom Interact, click on the Students tab.
2. Go to the Class menu and select New Class.  The Class Information window will

appear.
3. Type in the name of the class and select Anonymous under type.
4. Enter in the number of remotes in your class (e.g., 24 for 24 remotes).  The number

of remotes will be the number of users in the anonymous class (e.g. 24 remotes-
there will be 24 anonymous users in the class).  You may include and fill in any other
information.

5. Click on Done when finished.

4.2 Students

You can either add new students or existing students into a class.

Creating a New Student
1. In Qwizdom Interact, click on the Students tab.
2. Select the class you want to add students to in the Class drop-down menu.

3. Click on the  Add Student button.  The Add a Student window will appear.
4. Select "I want to create a new student who is not already in the system" and them click

on the  Create New Student button.  The Student Information
window will appear.

NOTE:  The fields marked in red are required; Name, Gender, Student ID, etc.
5. Fill out the required fields (in red)-Last Name, First Name, Gender, Student ID, and

Remote Number.
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6. To add a photo, click on the Upload button to select a photo.  All other fields are
optional.

7. Click on Done when complete.

Adding Existing Students by ID
1. In Qwizdom Interact, click on the Students tab.
2. Select the class you want to add students to in the Class drop-down menu.

3. Click on the  Add Student button.  The Add a Student window will appear.
4. Select "I want to add an existing student for whom I know the Student ID."
5. Type in the student's ID in the Student ID field.
6. Click on the Add button to add the student to the class.
7. Click on Done when complete.

Adding Existing Students from the Master List
1. In Qwizdom Interact, click on the Students tab.
2. Select the class you want to add students to in the Class drop-down menu.

3. Click on the  Add Student button.  The Add a Student window will appear.
4. Select "I want to add an existing student from the Master Student List."
5. Click on the gray column to highlight the student.  To select more than one

student at a time, hold down the Control key while selecting students with the
mouse.

6. Click on the Add Selected Student(s) button to add the student(s) to class.

4.3 Teacher Setup

1. In Qwizdom Interact, click on the Students tab.
2. Go to the Class menu and select Edit Teachers.
3. These are the required fields; First Name, Last Name, Username, Password, and Re-

type Password.

4. Click on the  Add New button and begin typing in the first name,
middle initial, and last name.

5. Type in a username and password.  This is what you will use to log into Interact and
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is a necessary security feature.
6. Check the "Has Administrative Rights" box.  This feature allows you to disable and

enable the login feature (for security and Student Mode).

7. Click on  Update to add the teacher and save changes.

8. Click on  Done when finished.

Deleting Teachers
1. In Qwizdom Interact, click on the Students tab.
2. Go to the Class menu and select Edit Teachers.
3. Select the name of the teacher under the Teachers section and click on Delete to

remove teacher.
4. When you click on Delete, if the teacher has assigned classes, a window will appear

asking you to either reassign or delete the classes.

5. Click  Done when finished and you will be taken back to the Students
tab.

4.4 Login

You must be a teacher with administrative rights to enable and disable the login.

Enabling Login
For security reasons, enable login to prompt users to type in a username and password to

access Qwizdom Interact.
1. Open Qwizdom Interact.
2. Go to File and select Enable Log In.  Be sure to have created your username and

password. See Teacher Setup for more information.
Log in must be enabled for Student Mode. See Student Mode for more information).

Disabling Login
Disabling login allows anyone to have access to Qwizdom Interact.

1. Open Qwizdom Interact.
2. Go to File and select Disable Log In.

Log in must be enabled for Student Mode. See Student Mode for more information.

If you are unable to log in, please contact Tech Support.

4.5 Group Setup

There are two ways of creating groups-automatically and manually.  Groups are necessary
for certain games.
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Creating Groups (Automatically)
1. In Qwizdom Interact, click on the Students tab.
2. Select the class, in the Class drop-down menu, you want to create groups for.

3. Click on the  Groups button.  The Group Management window will open.
4. In the Automatic tab, select the Grouping Action.

· Balance-groups students by ability
· Group-groups students evenly; one team may be odd depending on the

number of students in your class
· Random-groups students randomly; groups may be odd/even
· Group Size-specify the number of students in each group
· Exclude Absent Students-check this box to ignore students who are absent

(go to Attendance for more information)
Assign Partners Based On-you are able to assign partners based on ability and
performance
Select an Activity-use this drop-down menu to select the activity when you are
assigning partners based on selected activity performance.
· Overall Performance-based on overall grade in class
· Selected Activity Performance-based on overall grade on a particular activity
· Predefined Ability Rating-based on student's capability of learning

5. Under Grouping Action, select Balance.
6. Select Overall Performance under Assign Partners Based On.
7. Click on Create and then click on Done when finished.
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Creating Groups (Manually)

1. Click on the  Groups button.  The Group Management window will open.
2. Select the Manual tab.
3. Click on the Clear button to clear the previously made groups.
4. Click on New Group to make groups (e.g., Group 1, Group 2).
5. Click on a student and then drag and drop the selected student into the desired

group.
· Clear-clears out groups created
· New Group-creates groups (e.g., Group 1, Group 2)
· Remove-removes the selected student from that group

6. Click Done when you are finished.

4.6 Seating Chart

The seating chart is used to track student seating and needs to be completed to take
attendance.  See Attendance for more information.

1. In Qwizdom Interact, click on the Students tab.

2. Select the class you want to setup the seating chart for and click on the 
Seating Chart button to bring up the seating chart.

TIP: Click on the  button to display the list of student names with their user ID

and remote number. Click on the  button to display the seating chart.
3. The name of the class will appear at the top and the students will be in a column
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on the right.
4. Click on the Arrange button.  The Seat Setting window will appear.
5. In the Seat Setting window, select the seating pattern, choose the furniture (you

can select to show the teacher desk), and type in the number of rows and columns
under Arrangement.

6. Click the Arrange Seat button when finished.
7. You can manually move students around by clicking on the student and dragging

them to the desired location to adjust the seating arrangements.
8. Click on Save when you are finished.

4.7 Attendance

The seating chart must be completed before you start taking attendance. See
Seating Chart for more information.

1. In Qwizdom Interact, click on the Students tab.
2. Select the class you want to take attendance in.  Before you go into the attendance

chart, be sure to have your class list and seating chart done.

3. Click on the  Attendance button to bring up the attendance chart.
4. Mark the attendance of each student.
5. Click on Save when finished.

Attendance by Remote Login
1. In Qwizdom Interact, click on the Students tab.
2. Select the class you want to take attendance in.  Before you go into the attendance

chart, be sure to have your class list and seating chart done.
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3. Click on the  Attendance button to bring up the attendance chart.
4. Select "Use Remotes."  The host will initialize.  All the students will be marked

absent (red) until they log in with their ID.
5. Under Remote #, select Use Roster #, Random, or Fixed Remote #.  Students can

either sign in with their ID or turn on their remotes to log in.
6. Using the RF remotes to log in, press the Menu key.
7. Select Login and press the Send (double arrows) key.
8. The students would enter their ID and press the Send (double arrows) key.
9. Click on Save when finished.

4.8 Managing Classes and Students

Editing a Class
1. In Qwizdom Interact, click on the Students tab.
2. Go to the Class drop-down menu to select the class you want to edit.
3. Go to the Class menu and select Class Properties to edit the class such as the class

name.

4. When complete, click  Done to save changes and exit out of the
window.

Editing a Student
1. In Qwizdom Interact, click on the Students tab.
2. Go to the Class drop-down menu and select the class of the student you would like

to edit.  The class you selected will open.
3. Double-click on the student you would like to edit.

4. When complete, click  Done to save changes and exit out of the
window.

Deleting a Student
1. In Qwizdom Interact, click on the Students tab.
2. Go to the Class drop-down menu and select the class of the student you would like

to delete.
3. There are two ways in deleting a student from the class:  select the student and

click on the  Delete button OR  double-click on the student and click on

the  Delete From Class button.
4. To completely delete a student out of the program, click on the

 Delete From Master List button.
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NOTE:  To permanently delete a student from Qwizdom Interact, you must delete the
student from the master list.
5. A prompt will appear asking "are you sure you want to delete this student from the

current class?  (this will also delete student's answers/scores)."
6. Click OK to delete the student or Cancel.

Deleting a Student from the Master List
1. In Qwizdom Interact, click on the Students tab.
2. Go to the Class menu and select Edit Master List.
3. Select the student you want to delete and click on the Delete button.  You can

select more than one student at a time by holding down the Control key as you
select the students.  When you delete a student from the master list, you are
permanently removing the student from Qwizdom Interact.

4. Click on Done when finished.

Deleting a Class
1. In Qwizdom Interact, click on the Students tab.
2. Go to the Class drop-down menu and select the class you would like to delete.
3. Go to the Class menu and select Delete Class.
4. A prompt will appear asking "are you certain you wish to delete the current class?"
5. Click OK to delete the class or Cancel.

4.9 Importing and Exporting Classes and Students

Class lists can be imported from Qwizdom Teaching Assistant (TA), Excel or grade book
programs in .CSV or .txt file format.

If you created a class list in Microsoft Excel and save it as a .CSV file, you can import it into
Qwizdom Interact.

1. In Microsoft Excel, go to the File menu and select Save As.  The Save As window will
open.

2. Type in the name of the class list.
3. Click on the Save as Type drop-down menu.
4. Select CSV (Comma Delimited) (*.csv) as the file type the class will be saved as.
5. Select a location you want the class to be saved in and click on Save.

Now follow the instructions (below) for Importing a .CSV File into Interact.

Importing a .CSV File into Qwizdom Interact
1. In Qwizdom Interact, click on the Students tab.
2. Go to the Class menu and select New Class.
3. Type in the name of the class along with filling out other necessary information

and click Done.
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4. Go to the File menu and select Import, then Students.
5. Search for the file (should be in .CSV file format-comma delimited or it can be in a

.txt file format).
6. Select the file and click Open.  The Student Import window will appear.

NOTE:  When importing the student's gender, the code for the gender should be
either M or True for male and F or False for females

7. You are able to drop down the fields to select the information that will be
imported.  Be sure the fields on the right match up to the information on the left.

8. Uncheck the "First Record is Header" if the first record aren't headers.  If the first
record is a header, the information on the left will not have student information.  It
will have the column heading information from where you are importing the file
from (e.g., First name, Last name, etc.).  See image below.

9. Click on Import.  The created class will appear.

Exporting a Class from Qwizdom Interact into Excel
You are also able to export students into Excel, other grade book programs, or into Interact

on another computer.
1. In Qwizdom Interact, click on the Students tab.
2. Go to the Class drop-down menu and select the class you want to export.  The

class you selected will open.
3. Go to File and select Export then Students.
4. The Student Export window will appear.
5. Select Student Information under "What would you like to Export?" and Comma

Delimited.
6. Select the destination of where the file will be saved and then click Export when

finished.  The file will export and save to where it was directed to (e.g., My
Documents, Desktop).

Exporting a Class from Qwizdom TA
1. Open Qwizdom TA and click on the  Students button.
2. Double-click on the class you would like to export.
3. Go to the File menu and select Export.
4. A prompt will appear asking "Which do you want to export?"
5. Select Students.  The Export Students window will appear.
6. Select the fields that have information such as Last and First Name, ID, Username.

Do not export fields that are blank.
7. Click on Export.  An export file window will appear.
8. Find a location to save the class and click on Save.  It will save in a .txt file format.
9. Click the Quit button to exit out of Qwizdom TA.

Importing a Qwizdom TA Class into Qwizdom Interact
1. In Qwizdom Interact, click on the Students tab.
2. Go to the Class menu and select New Class.
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3. Type in the name of the class along with any other information you would like to
fill out.

4. Click Done when class information entry is complete.
5. Go to the File menu and select Import, then Students.  The Open window will

appear.
6. Search for the exported class (it will be in a .txt file format) and select it.
7. Click on Open.  The Student Import window will appear.

NOTE:  When importing the student's gender, the code for the gender should be M or
True for male and F or False for females
8. Select the appropriate columns for each field (e.g., Scott Jenkins; Scott goes into

the First Name column, Jenkins goes into the Last Name column).  You only need to
select the matching columns for each field for one student to set all other students
in the class.  If you do not know or can't remember what the imported field is for,
select it as "None" in the Qwizdom Interact column.

9. If the student's information appears under the Imported File column, uncheck the
First Record is Header box.  If there are heading names under the Imported File
column, check the First Record is Header box.  The first record in the image above is
not a header so the box is unchecked.

10. Click on Import when complete.  The class will appear in the grade book.

5 Chapter 3

5.1 Remote Setup

Testing your remotes ensures that the student and teacher remotes are sending and
receiving signals to and from the host; and the host is operating properly.

Q4 RF and Q5 RF Remote Setup
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· Change-this is where you select the remote type you are using
· Classroom Set-select this option if the same group of remotes will always be used

with the same host (receiver). This scenario is most common in K-12 settings. If you
are going to share the set of remotes, you can still use this mode as long as the
remotes always stay with the same host. The remotes are assigned a fixed number
and the session ID is permanently assigned to the remotes. Students may still log in
using their student ID/user ID if you select the option in the Presentation Setup
window. This option allows the student to pick up any remote rather than having to
use the same remote each time.

· Roaming or Student Owned-check this option for university settings or situations
where the students will keep possession of the remotes and may be in several
classes where different hosts are used. In this mode, the students must have a
numerical student ID/user ID to put into the remote, and each time the remote is
used a new session ID must be entered into the remote.

· Enable Backlight-select to activate the remotes Backlight
· Teacher Remote-select to activate the instructor remote
· Lowest Number/Highest Number-the lowest number would be the first remote in

the remote set and the highest number would be the last remote in the remote set.
(e.g., a 32 remote set; lowest number is 1, highest number is 32)

· Test-this is where you test that your remotes and host are responding correctly.  You
only need to test your remotes once to make sure all remotes are responding
correctly.  The only other time you should use this option is when you think your
remote/host isn't working properly.

· Assign Fixed Numbers-click this button if you selected Classroom Set to assign
remotes a fixed number.  Assigning fixed numbers assigns an internal number on
the remote (e.g. remote #1, remote #2, etc.).

· Renumber-reassigns class remotes.  When you click on Renumber, a window will
appear asking if you would like to reassign remote numbers for Current Class, My



Qwizdom Interact User Guide39

Qwizdom, Inc. 2007

Classes, or All Classes.  Select the option of your choice to reassign the remotes.  The
remotes will be reassigned in numeric order from the first student in alphabetic
order.

Q3 IR Remote Setup

· Change-this is where you select the correct remote type you are using
· Teacher Remote-make sure this option is checked in order to activate the teacher

remote
· Lowest Number/Highest Number-the lowest number would be the first remote in

the remote set and the highest number would be the last remote in the remote set.
(e.g., a 32 remote set; lowest number is 1, highest number is 32)

· Test-this is where you test that your remotes and receiver are responding correctly.
You only need to test your remotes once to make sure all remotes are responding
correctly.  The only other time you should use this option is when you think your
remote/host isn't working properly.

· Renumber-reassigns class remotes.  When you click on Renumber, a window will
appear asking if you would like to reassign remote numbers for Current Class, My
Classes, or All Classes.  Select the option of your choice to reassign the remotes.  The
remotes will be reassigned in numeric order from the first student in alphabetic
order.

1. Click on the  Remotes button.  The Remote Options window will appear.
2. The Remote Type area is where you select the type of remote you have.  Click on the

Change button under Remote Type.  The Change Remote Type window will appear.
3. Select your remote type to the Q3 Blue with 19 Buttons (2002-Present) and click OK



40

Qwizdom, Inc. 2007

when done.  You will be taken back to the Remote Options window.
4. The Teacher Remote box should be checked (if you are not using a teacher remote,

then leave the box unchecked).
5. The Lowest number is the first remote of the set and the Highest number is the last

remote of the set (e.g., set of 1-24 remotes, lowest-1, highest-24).

Testing IR Remotes
1. Click on Test.  The host will initialize and the Test Remote screen will appear.  There

will be a gray box of each remote number on the screen.  (If it doesn't initialize, be
sure the correct remote type you are using was selected.  Go to  Initializing the
Host for troubleshooting.)

2. Press any key on the remote to test it; the number of the remote will light up in
blue on the screen (e.g., press the 2 key on remote #5, remote #5 will light up in blue
on screen) and the right/wrong lights on the remote will flash.

3. Select Close once you are done to exit the Test Remote screen and you will be taken
back to the Remote Options window.

4. Click OK to exit.

The Q5 RF student and instructor remotes need to be charged 24 hours before using.

1. Click on the  Remotes button.  The Remote Options window will appear.
2. The Remote Type  area is where you select the type of remote you have.
3. Click on the Change button under Remote Type.  The Change Remote Type window

will appear.
4. Select your remote type to one of the RF remotes and click OK when done.  The

host will initialize (if the USB drivers were properly installed and the correct remote
type was selected).  If the host does not initialize, please see Initializing the Host
for troubleshooting.  You will be taken back to the Remote Options window.

5. Select Classroom Set or Roaming or Student Owned.  Most users will select Classroom
Set.  Roaming or Student Owned are intended for higher education such as colleges,
universities, etc.

6. The Teacher Remote box should be checked (if you are not using a teacher remote,
then leave the box unchecked).

7. The Lowest number is the first remote of the set and the Highest number is the last
remote of the set (e.g., set of 1-24 remotes, lowest-1, highest-24).

Assigning Fixed Numbers
If you have selected Classroom Set, follow the steps below.  If you have selected to use
Roaming or Student Owned, you do not need to assign fixed numbers.

1. Be sure the remotes are turned off and click on the Assign Fixed Numbers button.
The Assign Remotes screen will open.  There will be a gray box of each remote
number on the screen.

2. Turn on a student remote, enter in the session ID (session ID is located in the
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remote options title bar), and press the Send key.  The number of the remote will
light up in blue on the screen and the remote number will appear on the LCD
display on the remote.

3. Repeat step 2 for the rest of the remotes.  The remotes will number sequentially in
the order you turn them on.

4. After all the remotes have been assigned fixed number, click on the Save button.
You will be taken back to the Remote Options window.

5. Click OK to exit out of the Remote Options window.

Testing RF Remotes
You only need to test the remotes once to ensure the remotes are responding correctly.
The only other time you should need to test remotes again is when you suspect a remote
or host isn't working properly.  If you have selected to use Roaming or Student Owned, you
do not need to test your remotes.

1. Click on the Test button in the Remote Options window.  The Test Remotes screen
will open.  There will be a gray box of each remote number on the screen.

2. Turn on the student remotes.  The number of the remote will light up in blue on
the screen.

3. After all the remotes have tested correctly, click on Close to exit the Test Remote
screen and you will be taken back to the Remote Options window.

4. Click OK to exit out of the Remote Options window.

5.2 RF Remote Setup

Place the AA batteries in the Q4 RF remotes and charge the Q5 RF remotes.

Session IDs help Q4 RF and Q5 RF remotes identify where to send information to.  The
session IDs prevent the remotes sending the information to another host.

K-12 or Corporate Setting

1. Click on the  Remotes button.  The Remote Options window will appear.
2. Turn on a remote; if using Q4, hold down Menu key, if using Q5, turn power switch

to right.
3. The remotes may ask for a session ID. A session ID is a six-digit number that tells the

remotes which host it will communicate with. The session ID is in located in three
places: bottom of RF host on a white sticker, Remote Options window title bar, and
in the presentation title bar.

4. Click on the Assign Fixed Numbers button.
5. Turn the remotes on in the order you want them numbered. There are remote

number stickers provided in your remote set to number the outside of your
remotes (optional).

6. If the remotes say "Host not Found" or "No Net", then the incorrect ID was entered
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into the remote. To re-enter the session ID on the Q4 remote, press the Menu key,
use the right arrow to scroll to Sess. ID, and press the Send (double arrows) key to
select the option. The remote may say there is an existing ID and will ask if you
want to change it. Press T for to change. Enter the new session ID and press the
Send (double arrows) key to confirm. To re-enter the session ID on the Q5 remote,
press the Menu key and use the down arrow to scroll to Session ID. Press the Send
(double arrows) key to select it and enter the new session ID. Press the Send
(double arrows) key to confirm.

7. When the remotes connect to the host, the gray remote boxes on screen will light
up in dark gray and the remote LCD screens will display "Qwizdom" with the
remote ID in the upper right.

8. Click on Save and then click on OK to exit the Remote Options window.

College/University Setting

1. Click on the  Remotes button.  The Remote Options window will appear.
2. Turn on a remote; if using Q4, hold down Menu key, if using Q5, turn power switch

to right.
3. The remotes may ask for a session ID. A session ID is a six-digit number that tells the

remotes which host it will communicate with. The session ID is in located in three
places: bottom of RF host on a white sticker, Remote Options window title bar, and
in the presentation title bar.

4. Click on the Test button.
5. Turn the remotes on. If the remotes say "Host not Found" or "No Net", then the

incorrect ID was entered into the remote. To re-enter the session ID on the Q4
remote, press the Menu key, use the right arrow to scroll to Sess. ID, and press the
Send (double arrows) key to select the option. The remote may say there is an
existing ID and will ask if you want to change it. Press T for to change. Enter the
new session ID and press the Send (double arrows) key to confirm. To re-enter the
session ID on the Q5 remote, press the Menu key and use the down arrow to scroll
to Session ID. Press the Send (double arrows) key to select it and enter the new
session ID. Press the Send (double arrows) key to confirm.

6. When the remotes connect to the host, the gray remote boxes on screen will light
up in dark gray and the remote LCD screens will display "Qwizdom" with the
remote ID in the upper right.

7. Click on Save and then click on OK to exit the Remote Options window.

Changing Session IDs
If the RF remote says "No Net," it could be that the session ID has been entered incorrectly.

1. To change the session ID, wait for the remote to say "No Net."
2. Press the Menu key when the remote says "No Net."
3. Use the arrows to scroll to Enter Session ID or Sess. ID.
4. Press the Send (double arrows) key to select the option.  For the Q4 remotes, the
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remotes will display the current session ID and will ask if you would like to change
the ID.  Press T (Yes) to change the session ID.

5. Enter the session ID and press the Send (double arrows) key.

5.3 Remote Login

Student remote login allows any student to use a remote and sign in.  It does not have to
be their assigned remote.  This option is helpful when you:

· do not have assigned remotes
· have absent students
· have random people using remotes (e.g., during lectures, presentations)

To have students sign in, they must have a student ID.  Student ID's are setup in the
Student Information window.  (Go to Creating a Class for more information about student
information).  Each student should have a unique student ID assigned to their name.
Student ID's can only be numeric and 8 digits for Q5 remotes/9 digits for Q4 remotes.  An
ID cannot be used for more than one student (student IDs cannot be duplicated).

RF Remote Login

1. Select an activity and click on the  Present button.  The Presentation Setup
window will appear.

2. To enable students to login with their ID, check the Log In By User ID box under the
Remotes section.

3. Check the preferred options and select the class.
4. Click Okay when you are finished setting up the presentation.
5. The registration screen will appear.
6. Have each student type in their student ID and hit the Send key.  (e.g., a student will

press 0-4-3-1-0-4 on the remote and then hit the Send key to log on)
7. Their name and the number of their remote will appear on screen.
8. If the student keys in the incorrect ID, or two or more students attempt to enter the

same student ID, the name of the student will appear in the Login Conflict log.
9. The instructor can choose to Kick, Keep, or Remove the students attempting to log

in with a duplicate student ID.
Kick-denies student access to the presentation
Keep-allows that student to use the student ID
Remove-removes the student and has them re-enter the correct student ID

10. If a student enters in a non-existing student ID for that class, the remote will refuse
it and ask for the user ID again.

11. After all students have logged in, click on OK to begin the presentation.

IR Remote Login
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1. Select an activity and click on the  Present button.  The Presentation Setup
window will appear.

2. To enable students to login with their ID, check the Log In By User ID box under the
Remotes section.

3. Check the preferred options and select the class.
4. Click Okay when you are finished setting up the presentation.
5. The registration screen will appear.
6. Have each student type in their student ID and hit the Send key.  Their name along

with the number of the remote will appear on screen.  (e.g., a student will press 0-4-
3-1-0-4 on the remote and then hit the Send key to log on)

7. If the student keys in the incorrect ID, have them hit the Clear button on their
remote and then enter in their student ID.
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5.4 Q3 IR Remote Diagram

Student Remote

1. CLR (Clear) key-clears the information from the remote queue
2. Question [?] key-signals help to instructor
3. Delta (triangle) key-allows students to change their answer during an answer key

presentation
4. Send key-press to submit answer
5. Right/Wrong indicator-lets students know if their response is correct/incorrect

(this feature can be disabled) or received (both lights will flash)
6. True/Yes and False/No keys-use to answer True/False and Yes/No questions

Instructor Remote
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1. CLR [Clear] key-toggles the status bar during presentation and hides the response
graph/chart

2. Question [?] key-press this with an answer and then hit the Send key to pose a
spontaneous question

3. Delta [triangle] key-displays/hides the response graph/chart
4. Send key-toggles the menu bar, enters spontaneous questions, and exit out of

scores or student log in information screen
5. T [Right] and F [Wrong] keys-mark students correct/incorrect
6. 7 [<< Left double arrow] key-goes back to the previous slide set
7. 8 [Pick] key-randomly calls on a student and displays their name
8. 9 [>> Right double arrow] key-advances to the next slide set and game

setup/options menus
9. . [< Left single arrow] key-goes back to the previous slide within a slide set or to a

different response graph
10. 0 [Play] key-starts, pauses, and continues an autopilot presentation or video/sound

clip.  To manually play a video on a slide, press Play and then 1 on the instructor
remote.  If there are two videos on one slide, press Play and 1 for the first video and
then Play and 2 for the second video.  You can set options for the video to play
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automatically  Go to Multimedia for more information.
11. / [> Right single arrow] key-advances to each individual slide within a slide set or to

a different response graph
12. - [Show] key-displays students groups, scores, and remote assignments

5.5 Q4 RF Remote Diagram

Student Remote

     

1. Send  key-press to submit answer

2. Menu [power] key-press to view menu options (use the scroll  keys to

scroll through options and press Send  key to select the option).  Holding the
Menu button for two seconds will turn the remote on/off.  The remotes do not
automatically turn off.  Turn off remotes if they are not in use.  Search, Sess. ID, and
User ID, and Exit are options available in the Menu.  When you're in presentation,
the menu items are Help, Login User Id, and Exit.

3. Help-press Menu during presentation to request help.
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4. Clear [C] key-press to delete response

5. Scroll  keys-to scroll through menu options or answer choices
6. True/Yes and False/No keys--use to answer True/False and Yes/No questions

5.6 Q5 RF Remote Diagram

Student Remote

1. Send  key-press to submit answer
2. Clear [C] key-press to delete response or change an answer in an answer key

presentation
3. Thumb pad-press to navigate between letters when keying in answer and press

the button in the middle to select a letter or to scroll through menu options
4. Question [?] key-signals help to instructor during presentation
5. Menu key-displays menu options such as entering session ID and search again for

host.  Use the thumb pad to scroll through the menu options.  Search, Sess. ID, and
User ID, and Exit are options available in the Menu.  When you're in presentation,
the menu items are Help, Login User Id, and Exit.

6. Help-press Menu during presentation to request help.
7. True/Yes and False/No keys-use to answer True/False and Yes/No questions
8. Power switch-turns remote on/off.  The remotes do not automatically turn off.

Turn off remotes if they are not in use.
9. Light switch-turns Backlight on/off
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Instructor Remote (this is the instructor remote for Q4 and Q5 remote
sets)

1. Send  key-press to submit command
2. C [Clear] key-press to hide/show status bar and buzz in box
3. Thumb pad-press right or left to navigate between slide sets and menu options;

press up or down to navigate between question and answer slides.  Press the
button in the middle to select an option.

4. Help List [?] key-displays list of students who requested help on the LCD screen
5. Menu key-view menu options such as entering session ID and search again for

host
6. True/Right and False/Wrong keys-press to mark student responses correct or

incorrect
7. New Q [-] key-press to pose a spontaneous question.  See Spontaneous Questions

and Surveys for more information.
8. Pick [.] key-randomly calls on a student and displays their name on screen

9. LCD Graph  [0] key-displays the results of the class as a graph on the LCD screen
of the instructor's remote

10. Screen Graph  [/] key-displays the results of the class as a graph on the
computer (projector, television screen, etc.) screen for everyone to view.  Use the
up and down controls on the thumb pad to scroll through the different graphs.

11. Show [7] key-displays student groups, scores, and remote assignments
12. Play [8] key-starts, pauses, or continues an autopilot presentation or video/sound

clip.  To manually play a video on a slide, press Play and then 1 on the instructor
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remote.  If there are two videos on one slide, press Play and 1 for the first video and
then Play and 2 for the second video.  You can set options for the video to play
automatically  Go to Multimedia for more information.

13. Fn (Function) key-executes a unique function (this customized option must be
special ordered to access)

14. Power switch-turns remote on/off
15. Light switch-turns Backlight on/off.  The "Enable Backlight" box in the Remote

Options window needs to be checked to turn on the Backlight feature.

6 Chapter 4

6.1 Presentation

There are many options that can be set for presentation. Read the following to familiarize
yourself with the available options. Here are the four requirements to successfully run a
presentation; a class, remotes (if you will be using them), proper installation of the USB
Host, and an activity. Remotes can be turned on before and during presentation.

1. Select an activity in the content tree and click on the  Present button.  The
Presentation Setup window will appear.
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· Group-is where you select the class that will participate in the presentation.
· Play Mode-select the activity to play as Normal, AutoPilot, Answer Key, Review,

Spontaneous Survey, or Game.
· Record Answers/Scores-checking this box records the responses/score for an

activity.
· Just Participation-a rarely used option; an anonymous presentation for

sensitive material (survey) and does not record the responses/score but
appears in the grade book to show that the users participated.

· Display Options-allows features such as Answer Slides, Countdown Timer,
Slide Number, and Warning if % Wrong for viewing during presentation.

· Remote Options-allows user to setup remote options for a presentation.
· Randomize Slide Order-rearranges the slide order for that presentation only.
· Narrate Slides-this is a special order feature; checking this box turns on the

narrator for the presentation-see Narration for more information.
· Use Groups-turns on group mode when checked-be sure groups have been

created in the Students section.
· Time Limit-allows user to set time limit for question response or use time

from each slide set.
NOTE: Presentation Setup windows may vary depending on the version of the
software you have.  Go to Qwizdom's Web site to check for updates.

2. Click on the Group drop-down field and select the name of the class.
3. Click on the Play Mode drop-down field and select Normal as the presentation

type.
4. Check the "Use Remotes" box to use the remotes.
5. Select any other options you would like.
6. When the setup is complete, click OK.
7. After clicking OK, two messages will flash across the screen.  The first one will read

"Initializing Base."  This means the computer is responding and reading the host.  It
is attempting to establish communications with the host.  Once the computer
successfully establishes communications with the host, a second message "Base
Initialized on COM Port xx"0 will display.

8. The first slide of the presentation will appear.
9. Students will see the choices (depending on question type) on the remote LCD

screen.
10. To send in your response, select the choice or enter the number/text and press the

Send key to confirm the response. See Using Remotes in Presentation for more
information on responding with remotes.

11. When the presentation is complete, a prompt will appear stating that all (question)
slides have been answered. Click on the X in the upper left to exit the presentation.

Instructor Remote Tips
· Press the / key on the RF instructor remote to display the response graph; the delta

(triangle) key on the IR instructor remote.

http://www.qwizdom.com/index2.php
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· Press the / key on the RF instructor remote to close the response graph; the delta
(triangle) key on the IR instructor remote.

· Press the 0 key on the RF instructor remote to display the graph on the instructor's
LCD.

· Press the Pick (.) key on the RF instructor remote to randomly call upon a student
during presentation; the Pick (8) key on the IR instructor remote.

· Press the Play (8) key on the RF instructor remote to play/stop movie or sound on
slide; the Play (0) key on the IR instructor remote.

· Press the Show (7) key on the RF instructor remote to show current scores of
students/group during game mode; the Show (-) key on the IR instructor remote.

· Press the New Q (-) key to pose a spontaneous question. A list of question types will
appear on the LCD. Use the up/down arrows on the thumb pad to navigate through
the question types. Press the Send key to select the question type. Select the correct
answer and press Send; or the answer is survey only, press the Send key without
selecting an answer; the question mark key, the correct answer, and press the Send
key on IR instructor remote.

· Press the ? key to display the list of students who have requested help.

Presentation Features
Below is the presentation menu bar that displays during presentation:

 *Not all options will be available, depending on the
presentation type.

-Exits presentation and returns to Content tab.
-Hides/shows the drop-down menu at the top of the screen.
-Returns to the previous slide.
-Advances to the next slide.
-Marks student right.
-Mark student wrong.
-Picks a student at random.

-Shows current game scores during game mode presentation.
-Shows the question slide of the current slide set.
-Shows the answer slide of the current slide set.
-Shows the information slide of the current slide set.

Presentation Options
· To navigate through slides in a presentation, click on the  and  buttons; on

the IR instructor remote press the 7 and 9 keys (double arrows) or for the RF
instructor remote, press the left and right arrows (on the thumb pad) to navigate
through slides in a presentation.

· To navigate through individual slides (e.g., question, then show the answer), click on



Qwizdom Interact User Guide53

Qwizdom, Inc. 2007

the , , or  buttons; on the IR instructor remote press the . and / keys (single
arrow) or for the RF instructor remote, press the up and down arrows (on the thumb
pad) to navigate through individual slides.

· To toggle full screen and hide/show the top menu bar, click on the  button; on
the IR instructor remote, press the Send key or on the RF instructor remote, press the
C (clear) key to toggle full screen and hide/show the top menu bar.

· Press the Control key with the letter G key to display the response graph/chart; on
the IR instructor remote, press the Delta (triangle) key or on the RF instructor remote,
press the / key (chart with arrow pointing to right) to display the response
graph/chart.

· To exit the presentation, click on the X button in the left corner of the screen.

The Buzz In Box and Status Bar
The Buzz In Box displays the remote numbers at the bottom of the screen during
presentation (press the Control key with the letter B key show/hide Buzz In Box bar, press
the Control key with the letter H key to show/hide the Status Bar; on the IR instructor
remote, use the CLR key or on the RF instructor remote, press the C (clear) key to
show/hide both status bars).

The Status Bar allows you to see which remote has or has not responded in by the boxes
changing color.  Colored boxes indicate that the person with that remote has responded
in; it does not indicate that the student is right or wrong.

Presentation Options Associated with Remotes
· The  icon displays when the student(s) are required to input their answer and

hit the Send key on their remote.  This is only necessary for multiple mark, numeric,
and sequential questions.

· The  icon will appear when spontaneous questions are posed.

· This  icon will display when help is requested.  The number represents the
total of help requests. On the RF instructor remote, press the ? key to display the list
of the names requesting help. When using the mouse, click on the arrow to display
the students remote numbers that requested help.
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6.2 Using Remotes in Presentation

· To request help; on the student RF remote, press the Menu key to select Help and
press Send on the remote to request for help.  On the student IR remote, press the ?
key to request for help.

· To change the Session ID on the Q4 RF remote, press the Menu key and use the
right arrow to scroll through the menu options. When you see Sess. ID, press the
Send key to select it. An existing session ID may appear and the remote will ask if
you want to change it. Press T for yes and enter the new Session ID. Press the Send
key to confirm.

· To change the Session ID on the Q5 RF remote, press the Menu key when the
remote displays "No Host Found." Use the thumb pad to navigate through the menu
options and press the Send key to select Enter Session ID.

· To change the user ID on the Q4 RF remote, press the Menu key and use the right
arrow key to scroll to User ID. An existing user ID may appear and the remote will ask
if you want to change it. Press T for yes and enter a user ID. Press the Send key to
confirm.

Below are the procedures on how to respond for each question type during presentation:
· True/False; select T or F and press the Send key.

· Yes/No; select Y or N and press the Send key.

· Multiple Choice; select A, B, C, D, E, or F and press the Send key.

· Multiple Mark; select the letter choices and press the Send key.

· Numeric; enter the numbers and press the Send key.

· Sequence; enter the numbers in the order and press the Send key.

· Multiple Answer-List; press the letter choices and press the Send key.

· Fill-in/Completion; for Q5 remotes only-for one answer you will see:
1)___________________
*)Send
Make sure 1) is highlighted and press either the Circle or the Send key to select it.
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1)_______________ will appear on the LCD. Press the Menu key to display the
alphabet. Use the arrows on the thumb pad to navigate through the letters, using
the Circle key to select the letter(s). Press the Send key when finished entering the
answer. You will see 1)your answer. Press the down arrow on the thumb pad to
select *)Send and press the Send key to confirm the answer.
For two answers, you will see:

1)___________________
2)___________________
*)Send

Make sure 1) is highlighted and press either the Circle or the Send key to select the
question number. 1)__________ will appear on the LCD. Press the Menu key to
display the alphabet. Use the arrows on the thumb pad to navigate through the
letters, using the Circle key to select the letter(s). Press the Send key when finished
entering the answer. You will see 1)your answer.
Press the down arrow on the thumb pad to select 2)__________ and press the Circle
or Send key to select the question number. 2)__________ will appear on the LCD.
Press the Menu key to display the alphabet. Use the arrows on the thumb pad to
navigate through the letters, using the Circle key to select the letter(s). Press the
Send key when finished entering the answer. You will see 2)your answer.
Press the down arrow on the thumb pad to select *)Send and press the Send key to
confirm the answers.

· Short Answer-Specific; for Q5 remotes only. The alphabet menu will automatically
appear when this question type is displayed. Use the arrows on the thumb pad to
navigate through the letters, using the Circle key to select the letter(s). Press the
Send key to confirm your answer. 

6.3 Response Graph

The response graph shows the number of student responses for each of the available
choices during presentation.

1. After the students respond to the question, using the RF instructor remote,  press
the / key to display the response graph; press the Delta (triangle) key on the IR
remote; or use the mouse to click on the Show menu and select Question Response
Graph.  If you do not see a menu at the top of the presentation, click on the 
toggle button.

2. There are four types of charts; bar, scatter, pie, and individual.  To access the
different charts, either press the / (right single arrow) key or . (left single arrow) key
to select a graph OR use the mouse to click on the icons in the upper left-hand
corner of the graph window.
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Bar Graph-each bar represents the number of students that responded in with the
answer choices.
Scatter Graph-shows dot with the number of responses to the answer choices.
Pie Graph-shows pie slices with the number of responses to the answer choices.
Individual Response Chart-the chart shows each individual student's response.

6.4 Answer Keys

An answer key* is a paper-based activity that enables students to work at their own pace
and are automatically graded. Answer keys can be created from new or existing activities
and by importing ExamView (.XML) files. Students are allowed to change their answers if
the teacher permits.
*Answer keys can only be used with the RF remotes.

1. Click on the  New Activity drop-down menu and select Add
Answer Key.

2. Type in the name of the answer key.  The answer key will appear in the content
tree (on the left and the answer key grid will appear on the right).

There are six columns in the answer key:
· Number-the number of the question
· Type-the type of question being presented (e.g., multiple choice, short

answer, numeric, etc.)
· Answer-correct answer to the question
· Answer 2 (Alt, Min)-alternate answer or more than one answer to the
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question (e.g., answer is 70.9, but it can be rounded to 71 and be correct as
well).

· Answer 3 (Alt, Max)-alternate answer or more than one answer to the
question (e.g., selecting more than one choice for the answer)

· Points-number of points assigned to the question (e.g., question #1 is worth
25 points).

Select a question type and type in the answer for question one.

3. Click on the  Insert button below.  This will create another question.
4. Repeat step 4 and 5 until the answer key is complete.

5. Click on the  Save button to save the completed answer key.
6. Print and pass out the questions (generated from text books, another program,

etc.) to the students.  If you are printing a Qwizdom Interact activity, select the

activity in the content tree, and click on the  Print button.  The Qwizdom
Printing window will appear.

7. Click on Print and pass out the activity.  Students will work off the paper and use
the remotes to send the answers.

8. Select the answer key activity and click on the  Present button.  The
Presentation Setup window will appear.

9. Select the correct class under Groups and click OK.  A prompt will appear asking
"Do you want the students to be able to change their answers?  If you choose Yes, the
Right/Wrong feedback will be disabled."  Select Yes or No.  The presentation will
start.

Using an Existing Activity as an Answer Key
You can present (Q&A) activities as answer keys by selecting the Play Mode as Answer Key in
the Presentation Setup window.

1. Select an activity in the content tree and click on the  Print button.  The
Qwizdom Printing window will appear.

2. Click on Print and pass out the activity.  Students will work off the paper and use
the remotes to send in their answers.

3. Click on the  Present button.
4. Select the correct class under Groups and select Answer Key as the Play Mode or

check the Use as Answer Key box (options may vary due to version of software).
5. Click OK and it will start the presentation.
6. The Paper-Based Score Entry window will appear. You will see the student names
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with their ID and remote number.  As the students are taking the answer key, you
will see the questions as they are being completed (percentages will appear in
columns).  You can also track the students progress by viewing their names
(percentages will appear in rows).

7. Press the  Results Graph button to view the results of the class (results will
remain on screen).  You must press it each time you want to view the progress of
the class.

8. A prompt will appear asking if you would like to allow students to change their
answers.  Select Yes or No.  If you allow them the option to change their answers,
the right/wrong feedback will be turned off; which means, when they respond in,
they will not know if the answer sent in is right or wrong.

Multiple Answer Keys
Students can take different tests using one answer key*.
*Answer keys can only be used with the RF remotes.

1. Open Qwizdom Interact and click on the Content tab; or if Interact is already open,
click on the Content tab.

2. Select the activities in the Content Tree to print and pass out to students.  Students
will see the test ID on the activity printout (header).

3. Click on the  Present button drop down menu.
4. Select Present Multiple Tests (Answer Key Mode).  The Presentation Setup window will

appear.
5. Select the class and click OK when finished.
6. A prompt will appear asking if you would like to allow students to change their

answer.  Select Yes or No.
7. The answer key grid will appear. Students will enter the activity ID using their

remotes.  The activity ID lets the program know which student is taking a particular
activity.

8. You will see the final student's score once the activity has been completed.
9. When all the students have completed their activities, exit the presentation.
10. Click on the Students tab to go to the grade book to view the scores.

Answer Key Surveys
Answer keys* can be used for surveys using an anonymous class.  As an example of how
one can use an answer key survey, let's create a poll to elect a new class president.  In order
to do an answer key survey, you will need an anonymous class.
*Answer keys can only be used with the RF remotes.
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1. Go to the  New Activity button to the drop down menu and select Answer
Key.

2. Type in the name of the answer key and click on OK.  The answer key grid will
appear.

3. Select the question type (Multiple Choice, Yes/No, True/False) and select Survey as
the answer.

4. Click on  Insert to add more questions.

5. When the answer key is complete, click on the  Save button.

6. Click on the  Present button.  The Presentation Setup window will appear.
7. Select the anonymous class and check the preferred options.
8. Click OK and a prompt will appear asking "Do you want survey mode?  When a user is

finished, another user can start by pressing Send or Minus. This continues until you
close presentation."

9. Click on Survey.  The answer key grid will appear.
10. Users can send their response in using the remotes.  Say that you only have 30

remotes but there will be 100 users participating.  After a user sends in his/her
response, another user can pick up that same remote and send in his/her
response.

11. Using the IR remote, the next user would press the Send or - key on the remote and
then send in his/her answer.  Using the RF remote, the next user will press the right
arrow, enter his/her response, and press the Send key (double arrows).

12. When the survey is complete, exit the presentation by clicking on the blue X in the
upper left corner of the screen.

13. Click on the Students tab and click on the Reports button.  The Reporting wizard will
appear.

14. Select the class and activity.
15. Select the report type and click on View or Done (depending on the version of the

software) to generate a report.  The report will generate for you to view, e-mail,
print, or save.

6.4.1 Changing Answers During Answer Keys

When the presentation starts, it will ask "Do you want the students to be able to change their
answer?  If you choose Yes, Right/Wrong feedback will be disabled."  Disabling the
right/wrong feedback will discourage cheating.  Being able to change answers will allow
students to come back to certain questions they are having difficulty with.
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During presentation, a student is working on an answer key* activity.  The student is on a
question but would like to go back to change the answer for previous question.
*Answer keys can only be used with the RF remotes.

1. During an answer key, press the left and right arrows to go to the question that
you would like to change the answer for.

2. When the question number of the answer you want to change appears, press the
Clear button.

3. Select the answer and press the Send (double arrows) key.
4. Use the left and right arrows to get back to the question number you left off on.

6.4.2 Resuming Answer Keys

Answer keys* can be partially completed and finished later.  Follow the instructions below
to resume a partially completed answer key.
*Answer keys can only be used with the RF remotes.

1. Select the answer key that needs to be completed and click on the Present button.
The Presentation Setup window will appear.

2. Select the class under Groups and click Okay.  The presentation will begin.
3. A prompt will ask you if you would like to Resume, Start Over, or Cancel.  Click on

Resume.  The answer key will appear.
4. Students will scroll to the question number they left off on and complete the rest

of the activity.

6.5 Games

Using activities created in Qwizdom Interact can be presented as games giving students a
creative hands-on learning experience.

Here is what's needed to get started:
· An activity with remote answerable slides (e.g. Multiple Choice, True/False,

etc.).
· We recommend using 25 or more slides but it's not required.
· A class list with assigned remotes and groups so students are able to

participate and record scores.
· In the Presentation Setup window, select Game as the Play Mode and then

select the game type.

Some games restrict the number of players and can be played without remotes.  Charts
and solution slides are not available in game mode.  Groups cannot be used if you are
using Roaming or Student Owned.

Baseball  Individual and group; individuals and groups separated into two groups
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Fast Track  Remote only game, individual and groups; up to 80 individuals or groups-
remotes are required

K-Bowl  Individual and group; up to 32 individuals or groups

Mars Mission  Remote only game, individual and groups; up to 80 individuals or groups-
remotes are required

Millionaire  Individual and group; 2-8 individuals or groups

Quandary  Individual and group; up to 64 individuals separated into 8 groups

World Cup  Individual and group; individuals and groups separated into two groups

6.5.1 Baseball

Individual and group; individuals and groups split into two groups.

1. Before starting a Baseball learning game, open a Baseball activity or select an
activity and select the game option as Baseball.

2. Open Qwizdom Interact.
NOTE:  Baseball should be played with an activity with several slides.  Their should at
least be ten slides per inning.  If you will be playing seven innings, there should be
seventy slides.

3. Select the activity.
4. Click on the Present button.
5. The Presentation Setup window will appear.
6. Select the correct class that will be playing, check all the appropriate boxes

needed for this activity, and select the game type as Baseball.
7. Click OK.

Playing Baseball Using Remotes
1. Type in the name of the groups.
2. Set groups to be either odd/even or high/low groups.
3. Type in the number of players.
4. Set the Max Innings and Scoring Options.
5. Click Continue or press the 9 (double arrow) key on the teacher remote to proceed.
6. Click on Continue or press the 9 (double arrow) key on the teacher remote to

present the question.
7. A question is shown for the group at bat to answer.
8. Everyone from both groups responds to each question.  The outcome for each

play is determined by comparing the number of correct responses from each
group.  The outfield group controls the pitcher and therefore has first choice.
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Harder questions have a better chance of hitting a double, triple, or home run.  The
difficulty for each question is set in the Slide Editor screen.  An incorrect answer is
an out; a correct answer is a hit.

9. When you are done playing the game, you have the option to save.

Playing Baseball Without Remotes
1. Type in the name of the groups.
2. Set the Max Innings and Scoring Options.
3. Click Continue to proceed.
4. Click on Continue present the question.
5. A question is shown for the group at bat to answer.
6. When the group determines the answer, click on the Pick a Student button.
7. Click on the green check mark if they are right; click on the red X if they are wrong.
8. The outcome for each play is determined by comparing the number of correct

responses from each group.  The outfield group controls the pitcher and therefore
has first choice.  Harder questions have a better chance of hitting a double, triple,
or home run.  The difficulty for each question is set in the Slide Editor screen.

9. An incorrect answer is an out; a correct answer is a hit.
10. To show the answer after everyone has answered, click on the << (Left Arrows).
11. When you exit the game, you have the option to save.  When entering into an

activity that was previously recorded by the same class, you will receive a prompt
that will ask you if you would like to load, erase, or skip.

When you exit the game, you have the option to save.  When entering into an activity that
was previously recorded by the same class, you will receive a prompt that will ask you if
you would like to load, erase, or skip.

Load will resume the previously saved game for that class period.
Erase will erase the scores of that previously saved game and start new.
Skip will skip the previously recorded scores and play as new.

When you are done with the activity, you will be asked if you want to save.  Then you will
be prompted if you want to overwrite previously recorded scores.

6.5.2 Fast Track

Remote only game, individual and group; up to 80 individuals or groups can play-remotes
are required to participate.

1. Open Qwizdom Interact.
2. Select an activity.
3. Click on the Present button.
4. The Presentation Setup window will appear.
5. Select the correct class that will be playing, check all the appropriate boxes

needed for this activity, and select the game type as Fast Track.
6. Click OK.
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NOTE:  Multi-key remotes must be used in order to play this game.  This is a remote
only game.

In Fast Track, students or groups compete to answer the most questions correctly in the
fastest time.  This game is designed for up to 80 groups or players to play.
The game has four scoring modes:

1-Points are awarded based on how fast players respond; wrong answers = -300 points
2-Points are awarded based on how fast players respond; wrong answers = 0 points
3-Points are awarded based on order of response; wrong answer = -300 points
4-Points are awarded based on order of response; wrong answer = 0 points
5-Points are awarded based on order of top five responses; wrong answer = 0 points

· To show the answer (using remotes) after everyone has answered, on the IR
instructor remote, press the 7 key (<< Left Arrows) or on the RF instructor
remote, press the left arrow on the thumb pad.

· To show the answer (not using remotes) after everyone has answered, click
on the << (Left Arrows).

TIP:  The time limit can be set for all questions, or it can be indivually set with
different time limits within each slide set.

When you exit the game, you have the option to save.  When entering into an activity that
was previously recorded by the same class, you will receive a prompt that will ask you if
you would like to load, erase, or skip.

Load will resume the previously saved game for that class period.
Erase will erase the scores of that previously saved game and start new.
Skip will skip the previously recorded scores and play as new.

When you are done with the activity, you will be asked if you want to save.  Then you will
be prompted if you want to overwrite previously recorded scores.

6.5.3 K-Bowl

Individual and group; up to 32 individuals or groups can play.

1. Open Qwizdom Interact.
2. Select an activity.
3. Click on the Present button.
4. The Presentation Setup window will appear.
5. Select the correct class that will be playing, check all the appropriate boxes

needed for this activity, and select the game type as K-Bowl.
6. Click OK.

Using Remotes
1. The first person or group that sends in the correct answer gets the number of
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points awarded in the slide.
2. After the correct response has been received, the question slide is deactivated;

remotes will display Qwizdom and not be able to respond until the next question
appears.

3. The question will remain active until a correct response is received.
4. Press the Show button on the instructor remote to display the current scores;

correct responses are the point value set within the slide set, incorrect responses
will half the points of the value set in the slide set (e.g. for odd number points such
as 5, the points deducted will be 3, rather than 2.5).

5. When all slides have been answered, the person or group with the most points
wins.

Non-Remote Mode
1. If a group or individual answers the question correctly, click the Right button on

screen. The first person or group that answers the question correctly, gets the
number of points awarded in the slide.

2. After the correct response has been received, the question slide is deactivated so
click on the >> button to advance to the next slide.

3. If a group or individual answers the question incorrectly, click the Wrong button.
The question will remain active until a correct response is received.

4. Click on the Show button to display the current scores; correct responses are the
point value set within the slide set, incorrect responses will half the points of the
value set in the slide set (e.g. for odd number points such as 5, the points deducted
will be 3, rather than 2.5).

5. When all slides have been answered, the person or group with the most points
wins.

When you exit the game, you have the option to save.  When entering into an activity that
was previously recorded by the same class, you will receive a prompt that will ask you if
you would like to load, erase, or skip.

Load will resume the previously saved game for that class period.
Erase will erase the scores of that previously saved game and start new.
Skip will skip the previously recorded scores and play as new.

When you are done with the activity, you will be asked if you want to save.  Then you will
be prompted if you want to overwrite previously recorded scores.

6.5.4 Mars Mission

Remote only game, individual and group; up to 80 individuals or groups can play-remotes
are required to participate.

1. Open Qwizdom Interact.
2. Select an activity.
3. Click on the Present button.
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4. The Presentation Setup window will appear.
5. Select the correct class that will be playing, check all the appropriate boxes

needed for this activity, and select the game type as Mars Mission.
6. Click OK.

NOTE:  Multi-key remotes must be used in order to play this game.  This is a remote
only game.

In Mars Mission, students or groups compete to answer the most questions correctly in the
fastest time.  This game is designed for up to 80 groups or players to play.
The game has four scoring modes:

1-Points are awarded based on how fast players respond; wrong answers = -300 points
2-Points are awarded based on how fast players respond; wrong answers = 0 points
3-Points are awarded based on order of response; wrong answer = -300 points
4-Points are awarded based on order of response; wrong answer = 0 points

· To show the answer (using remotes) after everyone has answered, on the IR
instructor remote, press the 7 key (<< Left Arrows) or on the RF instructor
remote, press the left arrow on the thumb pad.

· To show the answer (not using remotes) after everyone has answered, click
on the << (Left Arrows).

TIP:  The time limit can be set for all questions, or it can be indivually set with
different time limits within each slide set.

When you exit the game, you have the option to save.  When entering into an activity that
was previously recorded by the same class, you will receive a prompt that will ask you if
you would like to load, erase, or skip.

Load will resume the previously saved game for that class period.
Erase will erase the scores of that previously saved game and start new.
Skip will skip the previously recorded scores and play as new.

When you are done with the activity, you will be asked if you want to save.  Then you will
be prompted if you want to overwrite previously recorded scores.

6.5.5 Millionaire

Individual and group; 2-8 individuals or groups can play.

1. Open Qwizdom Interact.
2. Select an activity.
3. Click on the Present button.
4. The Presentation Setup window will appear.
5. Select the correct class that will be playing, check all the appropriate boxes

needed for this activity, and select the game type as Millionaire.
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6. Click OK.

In Millionaire, groups compete to be the first to answer enough questions to win the
million dollar prize.  This game is designed for use with 2 to 8 individuals/groups.  There are
two different modes of operation; sequential and toss up.

· In sequential mode, questions are alternated between individuals/groups.
· In toss up mode, whoever buzzes in first answers the question.  The first

respondent with the correct answer has an opportunity to try to earn
points by answering the next question correctly.  (Every other question is a
toss up question.)

In each game mode, the individual/group has a chance to move up the scale to a million
dollars if he/she answers a question correctly.  If the individual/group does not know an
answer, he/she can choose to use one of the Help Lines.  Help Lines include:

Helping Hand-an individual/group chooses one of the other individuals/groups
to help out and both earn money based on their answer.

Random-if the question is a multiple choice question, the choices will be
narrowed down to two possible answers, one of which is the correct answer.

Skip-the individual/group can "pass" on this question and choose to be given a
new question.

Hot Potato-the question can be passed onto another group and that group
must answer the question correctly or drop two spots on the million dollar
scale.  This group does not earn money on the question.  The original group
will still earn money for a correct answer, but will not lose money from an
incorrect answer.

Once a Help Line has been used by an individual/group, that Help Line option is no longer
available.  You can only use each Help Line option once.
You can bring up the slides and mark students right/wrong using the Next and
Right/Wrong keys on the teacher remote.  Help Lines can be selected by using the 1-5 keys
(Help Lines are numbered).  Without a teacher remote, responses will be indicated via the
computer keyboard.

When you exit the game, you have the option to save.  When entering into an activity that
was previously recorded by the same class, you will receive a prompt that will ask you if
you would like to load, erase, or skip.

Load will resume the previously saved game for that class period.
Erase will erase the scores of that previously saved game and start new.
Skip will skip the previously recorded scores and play as new.

When you are done with the activity, you will be asked if you want to save.  Then you will
be prompted if you want to overwrite previously recorded scores.
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6.5.6 Quandary

Individual and group; up to 64 individuals or groups can play. There are requirements for
using an activity for Quandary. See Creating Game Activities to learn more about creating
a Quandary activity.

· 25 slides are required to completely fill the game board (five slides for each
of the five columns).

· It's recommended to have five different categories to but not required (go to
Edit menu and select Edit Quandary Topics).

· The slides must be remote answerable (Information slides and other non-
remote slides are not permitted).

1. Select an activity in the content tree that you would like to present as a Quandary
game.

2. Click on the Present button.
3. The Presentation Setup window will appear.
4. Select the correct class that will be playing, check all the appropriate boxes needed

for this activity, and select the game type as Quandary.
5.  Click OK.

Using Remotes
1. Select the game mode you would like to play in:

Mode 1-Traditional.  The first player or group to answer correctly gets all the points.
Up to 64 individuals or groups can play.
Mode 2-All Respond (remotes required).  Everyone responds and earns points for
their correct answers.  Up to 64 individuals in 8 groups can play.
Mode 3-All Respond with Penalty (remotes required).  Everyone earns points for
correct answers.  Points are deducted for wrong answers.  Up to 64 individuals in 8
groups can play.  In individual mode, individual responses count toward a group
total.

2. Start the game by selecting an individual or group to select a topic and point value
from the game board.  The individual or group can select any column but should
choose the lowest available value in that column.

3. Using the remote to select the categories and $$ amount: from left to right (1-5),
press the category number on the instructor remote (e.g., press 3 for third
category). Then use the 1-5 keys to select the $$ amount of the slide (e.g., 1=100,
2=200).  If you are using the mouse, just click on the desired square.

4. After all remotes have responded, the coin bank screen will appear displaying the
number of points each individual or group received for their correct responses.
The game board appears again.

5. This process continues until the game board has been completely cleared; or
when you select Quit from the File menu.  The individual/group with the most
points wins!

Non-Remote Mode
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1. Use the mouse to click on the $$ amount on the game board.
2. The individual or group that is up, will answer the question. If the individual or

group answers correctly, use the mouse to click on the green check mark button to
mark the individual or group right. If the individual or group gets the question
wrong, points will be deducted from their score (in the amount of the $$ value of
the slide). The screen will not advance to the game board until the question is
answered correctly.

3. After the question has been answered correctly, the screen will advance back to
the game board. Slides (and their value) that have been answered are removed
from the game board.

4. Click on the Show Current Scores bar (gray bar below the game board) to display
current scores.

5. This process continues until the game board has been completely cleared; or
when you select Quit from the File menu.  The individual/group with the most
points wins!

When you exit the game, you have the option to save.  When entering into an activity that
was previously recorded by the same class, you will receive a prompt that will ask you if
you would like to load, erase, or skip.

Load will resume the previously saved game for that class period.
Erase will erase the scores of that previously saved game and start new.
Skip will skip the previously recorded scores and play as new.

When you are done with the activity, you will be asked if you want to save.  Then you will
be prompted if you want to overwrite previously recorded scores.

6.5.7 World Cup

Individual and group; individuals and groups split into two groups.

1. Open Qwizdom Interact.
2. Select an activity.
3. Click on the Present button.
4. The Presentation Setup window will appear.
5. Select the correct class that will be playing, check all the appropriate boxes

needed for this activity, and select the game type as World Cup.
6. Click OK.

Playing World Cup Using Remotes
1. Type in the name of the groups.
2. Type in the number of players.
3. Set the time limit of the game.
4. Set the Scoring Options and Groups.
5. Click Continue or press the 9 (double arrow) key on the teacher remote to proceed.
6. Click on Continue or press the 9 (double arrow) key on the teacher remote to
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present the question.
7. A question is shown, to be answered by the group who has control of the ball.
8. Everyone from both groups responds to each question.  The outcome for each

play (who has control of the ball, out of bounds, making goals) is determined by
comparing the number of correct responses from each group.  Harder questions
have a better chance of controlling the ball and making a goal.  The difficulty for
each question is set in the Slide Editor screen.

9. An incorrect answer is a missed goal; a correct answer is a goal.
10. When you are done playing the game, you have the option to save.

Playing World Cup Without Remotes
1. Type in the name of the groups.
2. Type in the number of players.
3. Set the time limit of the game.
4. Set the Scoring Options and Groups.
5. Click Continue to proceed.
6. Click on Continue present the question.
7. A question is shown for the group who has control of the ball to answer.
8. When the group determines the answer, click on the Pick a Student button.
9. Click on the green check mark if they are right; click on the red X if they are wrong.
10. The outcome for each play (who has control of the ball, out of bounds, making

goals) is determined by comparing the number of correct responses from each
group.  Harder questions have a better chance of controlling the ball and making a
goal.  The difficulty for each question is set in the Slide Editor screen.

11. An incorrect answer is a missed goal; a correct answer is a goal.
12. To show the answer after everyone has answered, click on the << (Left Arrows).

When you exit the game, you have the option to save.  When entering into an activity that
was previously recorded by the same class, you will receive a prompt that will ask you if
you would like to load, erase, or skip.

Load will resume the previously saved game for that class period.
Erase will erase the scores of that previously saved game and start new.
Skip will skip the previously recorded scores and play as new.

When you are done with the activity, you will be asked if you want to save.  Then you will
be prompted if you want to overwrite previously recorded scores.

6.6 Spontaneous (On-the-Fly) Questions

Spontaneous (on-the-fly) questions can be posed during presentation to test what
students know and/or gather opinions/feedback. The spontaneous (on-the-fly) question
must be posed after the question slide is answered.

Posing a Spontaneous (On-the-Fly) Question (RF Remote)
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1. Select an activity in the content tree and click on the  Present button.
2. Check the preferred options and select the class.
3. Click OK to start the presentation.
4. Anytime during the presentation, after the class has answered the question

presented on the slide, ask the class a spontaneous (on-the-fly) question.
5. After asking the question, press the - (New Q) key on the instructor remote.
6. Select the question type by pressing the circle key (in the middle of the thumb pad)

or the Send key (double arrows).
7. Select the answer by pressing the circle key (in the middle of the thumb pad) or the

Send key (double arrows).  A  question mark icon will appear.  This icon tells
students a question has been posed.

8. Students will select the answer and press the Send key (double arrows) to send in
their response.  After the students have responded in, there are two ways to view
their results.  Either press the / key (chart with arrow pointing to right) so that
everyone can view the results or press the 0 key (chart) to privately view the results
on the instructor remote.

9. When the presentation is complete, exit by clicking on the blue X in the upper left
corner of the screen.

10. You are taken back to the Content screen.
11. Click on the Students tab.
12. Click on the activity name in the grade book (the column will highlight in yellow).
13. Click on the Reports button.
14. Select the Detailed Class Answer report and click on View.
15. The report will generate and the spontaneous (on-the-fly) responses will appear

after the activity questions.

Posing a Spontaneous (On-the-Fly) Question (IR Remote)

1. Select an activity in the content tree and click on the  Present button.
2. Check the preferred options and select the class.
3. Click OK to start the presentation.
4. Anytime during the presentation, after the class has answered the question

presented on the slide, ask the class a spontaneous (on-the-fly) question.
5. After asking the question, press the ? (question mark) key on the instructor remote.

6. Press the answer and then the Send key.  A  question mark icon will appear.
This icon tells students a question has been posed.

7. Students will select the answer and press the Send key (double arrows) to send in
their response.  After the students have responded in, press the Delta (triangle) key
on the teacher remote to pull up the graph.  The graph shows how many students
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answered each of the following choices.
8. When the presentation is complete, exit by clicking on the blue X in the upper left

corner of the screen.
9. You are taken back to the Content screen.
10. Click on the Students tab.
11. Click on the activity name in the grade book (the column will highlight in yellow).
12. Click on the Reports button.
13. Select the Detailed Class Answer report and click on View.
14. The report will generate and the spontaneous (on-the-fly) responses will appear

after the activity questions.

6.6.1 Spontaneous Survey Bar

The Spontaneous Survey bar comes in handy because it is a free floating bar that allows
questions to be asked using an activity* or another program.
*The activity must only contain one information slide.  This is required to receive accurate
results.

1. Select an activity that contains only one information slide.  If you do not have one,
then create a new activity with one information slide.

2. Click on the  Present button.  The Presentation Setup window will appear.
3. In the Presentation Setup window, check the appropriate boxes and select the

correct class.
4. Check the Use As Spontaneous Survey box.
5. Click Okay when finished and the presentation will start.
6. Interact will minimize and run in the background.  The survey menu will appear at

the top of the screen.
NOTE:  Double-click on the owl to toggle between Qwizdom Interact and another
program.

7. You can choose to type the question in the text box for everyone to view.
8. Select Multiple Choice as the question type and 4 Answer as the number of answer

choices.
9. Click on the Start button for the survey to begin.
10. Ask the question and give the answer choices for the class to choose from.
11. Students will send their responses using the remotes.
12. When all responses have been received, the graph will show 100% have

responded.
13. Click on the Stop button.
14. Either select the correct answer or leave the answer as Survey.
15. Click the pie chart icon to bring up the response graph.
16. Click on the New button to ask another question.  When you are finished with the

survey, click on the red X button to end the presentation.
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17. A prompt will appear asking you if you want to save your spontaneous question
answers.

18.  Click on Save.
19. Another prompt will appear telling you where the spontaneous answers are saved

at.  The spontaneous session files are saved as a .CSV file on the hard drive in the
Spontaneous Sessions folder in Qwizdom Interact (double-click on My Computer,
double-click on Program Files folder, double-click on Qwizdom folder, double-click
on Qwizdom Interact folder, double-click on Spontaneous Sessions folder).  Open
Microsoft Excel, Wordpad, Microsoft Works Spreadsheet or other .CSV supported
programs to see the results.

20.  Since this is a survey, there will not be grades for the activity, only responses.
21.  Select the activity and click on the Reports button.
22.  Select Detailed Class Answer report to view the results of the spontaneous activity.

6.7 Student Mode

Student mode allows students to complete missed assignments and tests.  Students must
have a username along with password to access student mode.  Go to Students for more
information on how to set up usernames and passwords.

1. Open the "Curriculum Samples" category/course.
2. Double-click on a folder to choose an activity from.
3. Select an activity.  The Activity Properties window will appear.
4. Click on Student Mode Properties.
5. Under the Student Access Mode section, select if the make-up assignment will be a:

· Test-student enters in answer, hits submit, and clicks on the next question
arrow

· Test With Feedback-after student selects/inputs answer, the program will
display whether the answer is right or wrong

· Lesson/Review-student enters an answer, the program will display whether
the answer is right or wrong and shows the answer slide

6. Select Test With Feedback.
7. Set the Time Limit to 0:45 minutes.
8. Set the Available make-up date.  You are allowing them to make-up the

assignment within a limited time period.
9. In the Allow Individual Access drop-down menu, select a class.  In the list below,

check the names of the students that will be making-up the particular assignment
you are assigning them. (Optional) Prerequisites are assignments that must be
completed before the student can begin their assigned activity.

10.  Click Done.

Logging into Student Mode
Be sure students have a username/password and login enabled to use Student Mode.

1. Exit out of Qwizdom Interact.
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2. Double-click on the Interact icon.
3. You will be asked for a username and password.
4. Type in a student username and password.
5. Click on Done.  The Student Mode window will appear.
6. Select the assigned activity that needs to be completed.
7. Click on Run Test to begin.
8. The first question of the activity will appear.
9. Enter in the answer and click on Submit.  Proceed to the next question.
10. When the activity is completed, a prompt will appear displaying your score.
11. Click OK once you've reviewed your score.  You will be taken back to the Student

Mode window.  The activity that was completed will be in red.
12. Click on Done to exit out of Interact.

7 Chapter 5

7.1 Grade Book

Qwizdom Interact has its own grade book system to track student answers, scores, and
overall grades.  In order to have grades, you must record them.  The option to record
answers/scores is available in the Presentation Setup window.

1. In Qwizdom Interact, click on the Students tab.
2. Recorded results will appear in the grade book in columns with the activity names

in the header.
3. You can change the view of the grades to percentage, fractions, or points.  To

change the way the results are displayed, click on the  Views button.
· Points-shows the total number of points awarded for each correct answer.

Points are assigned in each slide.  See Slides for more information.
· Fractions-shows grades as a fraction of the number of correct responses over

the total number of questions.  e.g., 8/10-the student got 8 correct out of 10
· Percentages-shows grades in percentage form based on the number of

correct responses.  e.g., 96%
· Grades-shows the letter grade based on number of correct responses.  e.g., A-

To print a report, go to E-mailing, Printing, and Saving Reports for more information.

Grade Scales
The grade scale you would like to set for the class can be adjusted.
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1. In Qwizdom Interact, click on the Students tab.
2. Go to the Class menu and select Edit Grade Scales.  There are four different grade

scales that can be set to your grading standards.  Select the grade scale or create a
new grade scale to edit to your grading standards.

3. To create a new grade scale, click on the New button and type in the name of the
grade scale in the GradeScale column.

4. Create the grades in the Grades Scales Settings column.
5. Click Done when finished.

Activity Score Adjustments
Scores in the grade book can be added or adjusted.  This is useful for adding extra credit
points.
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1. In Qwizdom Interact, click on the Students tab.
2. Select the class you would like to adjust the scores for.
3. Double-click on a field under the activity column.  The Activity Score Adjustments

window will appear.
4. Type in a student's score in the Score column.  The Adjustments column adds or

subtracts bonus and extra credit points.
5. The information in the Score and Adjustments column will automatically calculate

and appear in the Total column.
6. Click Done when finished adjusting scores.  The scores will appear in the grade

book.

Adding Graded Paper-Based Activities to the Grade Book
Grades for paper-based activities (not using Qwizdom Interact) can be entered into the

Qwizdom Interact grade book.

1. In Qwizdom Interact, click on the Students tab.
2. Select the class you would like to add an activity to.

3. Click on the  Add Activity button.
4. Type in the name of the paper-based activity you would like to enter in.
5. Click OK.  A prompt will appear asking the maximum points of the activity.
6. A prompt will appear asking you to specify the maximum amount of possible

points.  Enter in the maximum number of possible points.
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7. The added activity will appear in the grade book (in alphabetical order).
8. To add the grades, double-click on a field under the activity column.  The Activity

Score Adjustments window will appear.
9. Type in a student's score in the Score column.  The Adjustments column adds or

subtracts bonus and extra credit points.
10. The information in the Score and Adjustments column will automatically calculate

and appear in the Total column.
11. Click Done when finished adding all grades for the class .

7.2 Exporting Grades

You have the option to export grades into Microsoft Excel or certain grade book programs
that support the .CSV file format.  The grades will be exported in .CSV file format.  You
cannot import grades as a .csv file.

1. In Qwizdom Interact, click on the Students tab.
2. Go to the File menu and select Export, then Grades.
3. The Grade Export window will appear asking you what else you would like to

export.  It is best to leave all options under this section unchecked.  An export
window will appear.

4. Find a location to save the file (e.g., My Documents, Desktop) and type in the file
name.

5. Click on Save.  The file will be saved in .CSV file format which is supported by
Microsoft Excel or grade book programs (that support .CSV files).

7.3 Graded Activities

When activities are graded, they become locked.  There will be a colored lock icon on the
activity indicating that it has been graded.  Activities are locked to prevent any revisions
made to the activity which could affect grades that are linked to it.
If you want to make revisions to the activity, there are two A locked activity can be
duplicated or unlocked for revision.

Duplicating an Activity
1. Go to the File menu and select Duplicate.
2. Enter the name of the duplicated activity and click Ok.

NOTE:  Each activity name should be different (activity names should not be
duplicated).
3. The activity will be duplicated with the new activity name in the content tree.

Unlocking an Activity
Unlocking an activity deletes the activity and grades from all the classes that have taken
the activity.  If you want to keep the grades recorded for that activity, duplicating the
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activity would be the best suggestion.
1. Select the activity you would like to unlock.
2. Go to the File menu and select Unlock.  A prompt will appear letting you know that

by unlocking an activity, the grades attached to the activity will be deleted in the
grade book.

3. Click Yes to unlock the activity.

7.4 Reports

Reports detail: grades, student information, and attendance.  They can be printed and e-
mailed.  To set up the e-mail function please go to E-
mailing, Printing, and Saving Reports for more information.  If your reporting window
does not match the one below, you may need to update your version of Qwizdom
Interact.

Under the Class tab:
Overall Data Reports

· Class Attendance-daily attendance report for each student.
· Class Roster-displays student names, remote number, group number.
· Group Designations-displays the students in their assigned group with their remote

number.
· Detailed Class Roster-displays student names, remote number, group number,

student ID, username, and password.
· Grade Distribution-displays activity information with student information,

responses, and total score with pie chart and bar graph.
· Grade Book-displays activity information with student information, total grade, and

responses.

Specific Activity Reports
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· Sub-Group Summary Graph-grade distribution chart, demographic chart sub-group
chart, class high-low-average chart

· Question Summary-class responses by question
· Overall Score-summative scores by student
· Class Answer Report-answer report for all students per question
· Detailed Class Answer-detailed answer report by student per question
· Question Standards-specific standards attached
· Class Standards Mastery-lists all standards tested and class average for each

standard

Under the Student tab:
Overall Data Reports

· Score Report-individual score per activity
· Progress Report-individual student grade report
· Attendance-daily attendance report for individual student

Specific Activity Records
· Question Summary-student score by question
· Student/Class Comparison-individual student answer summary
· Standards Mastery-individual student standards mastery report

7.5 E-mailing, Printing, and Saving Reports

Emailing Reports
1. Open Qwizdom Interact and click on the Content tab; or if Interact is already open,

click on the Students tab.

2. Click on the  Reports button.  The Reporting wizard will appear.
3. Click on the Student tab.
4. Select the report type and/or activity name and student name.

5. Click on the  E-mail button.  The report will be sent to the e-mail address
that's located in the Personal Information section of the student's information.  Go
to Students for more information.

Printing Reports
1. Open Qwizdom Interact and click on the Content tab; or if Interact is already open,

click on the Students tab.
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2. Click on the  Reports button.  The Reporting wizard will appear.

3. Select the report type and click on the  Print button.

Saving Reports
1. Open Qwizdom Interact and click on the Content tab; or if Interact is already open,

click on the Students tab.

2. Click on the  Reports button.  The Reporting wizard will appear.

3. Select the report type and click on the  Save button.  The report will save as
a .PDF file.  Adobe Acrobat Reader is required to view the saved report.  If you do not
have Acrobat Reader, download the Acrobat Reader to view the reports.

8 Chapter 6

8.1 Database Backup and Restoration

Database Backup
The Qwizdom Interact database can be backed up and will be stored within the Qwizdom
Interact folder (C Drive\Program Files\Qwizdom\Qwizdom Interact\Backups).  You can
move the backup folder to another location. Backing up the database does not backup the
activities.  To save activities, you must export them to a disc or another location on your
computer.  See Importing and Exporting for more information.

1. To backup a database, open Qwizdom Interact.
2. Go to the File menu and select Backup Database.  A prompt will appear letting you

know that the backup is complete.
3. Click OK.

Database Restoration
1. To restore a database, open Qwizdom Interact.
2. Go to the File menu and select Restore Database.  A window will appear.
3. Double-click on the Backup folder and select the date of the backup you would like

to revert to.
4. After the restoration is complete, you will be prompted to exit and then re-enter

the program for changes to take effect.

http://www.adobe.com/downloads/
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8.2 Uninstalling Software and Hardware

Uninstalling Qwizdom Interact
Before uninstalling, be sure to export any materials such as activities, classes, and grades

you would like to save.
1. Go to Add/Remove programs in the Control Panel.
2. Search for Qwizdom Interact and click Remove.
3. Qwizdom Interact - InstallShield Wizard will appear and follow the instructions.
4. Do not restart your computer when finished.
5. Double-click on the My Computer icon.
6. Double-click on the C: Drive.
7. Double-click on the Program Files.
8. Double-click on the Qwizdom folder.
9. Select the Qwizdom Interact folder and delete it.  If the folder will not delete, restart

the computer and follow steps 5-9 to delete the Qwizdom Interact folder.
10. Restart the computer for changes to take effect.

Uninstalling USB Drivers
1. Go to your Control Panel from either your Settings or Start menu.
2. Double-click on System and click on the Hardware tab or Device Manager tab.  If

you go to the Hardware tab, click on the Device Manager button.
3. Search for the Qwizdom USB Base or Qwizdom RF Host under Universal Serial Bus

Controllers, Ports, and/or Other or Unknown Devices.
4. Double-click on the file and click on the Driver tab.
5. Select Uninstall.
6. Unplug your host after it is uninstalled and go back to the Control Panel.
7. Double-click on Add or Remove Programs and search for FTDI Universal Serial

Converter Drivers.
8. When you find it, remove the file.
9. Now plug your host in.  A prompt or wizard will appear notifying you of new

hardware.
10. Follow the steps above for Windows 98/2000/XP.

8.3 Troubleshoot

Use this troubleshoot to identify and solve problems related to using Qwizdom Interact.
Select the topic(s) that best describe the problem and then try the suggested steps.  You
may also go through our video tutorials to assist you with our program.

1) What do I do if I am being prompted to type in my username and password,
but it's not working OR I don't have one?

2) When I launch Qwizdom Interact, it says that I have a certain number of days
before my trial period ends.  Why am I receiving that prompt if I purchased
the software?

http://www.qwizdom.com/video_tutorials.php
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3) How do I register Qwizdom Interact?
4) Does my computer need internet connection to register?
5) Why is it saying "Invalid code" when I enter the product code?
6) Why am I getting a prompt that says "You are missing the license(s) to the

following Curriculum..."?
7) How do I register content?
8) Why is there a "0" or negative number (in the Content Manager window)

rather than showing the name of the curriculum I registered?
9) Why is the Present button grayed out when I try to present an activity?
10) How do I convert Qwizdom TA resources into Qwizdom Interact?
11) I converted the Qwizdom TA resources into Qwizdom Interact but the images

are missing.  How do I get the images to appear?
12) How do I export activities that I've created or imported into Qwizdom

Interact?
13) How do I import activities that I've exported from other computers with

Qwizdom Interact?
14) I created slides at home, how do I get those slides into Qwizdom Interact on

my computer at school?
15) How do I save in Qwizdom Interact?
16) I can't edit my slides anymore; most of my options are grayed out.  What

happened?
17) How do I unlock an activity?
18) How do backup the work I've done within Qwizdom Interact?
19) How do I restore my Qwizdom Interact to an earlier date?
20) How do I move my Qwizdom TA classes into Qwizdom Interact?
21) How do I import my class lists into Qwizdom Interact?
22) How do I export my class lists that I've created in Microsoft Excel or another

program so that I can import them into Qwizdom Interact?
23) Why am I getting a prompt that says "Invalid Lines" when I try to import my

class list into Qwizdom Interact?
24) In the Remote Options window, how do I know if I should use Classroom set or

Roaming or Student Owned mode?
25) What is a session ID and where do I find it?
26) When do I need to change my session ID and how do I do this?
27) I have an RF remote and entered in the wrong session ID.  How do I change

the session ID?
28) I am receiving an error that says "There is a problem with the base..."  What do I

need to do to get my host to initialize?
29) How do I get the green light to come on the host?
30) The green light on the host is on, but the host still won't initialize.  What do I

do?
31) My remotes are not responding.  How do I get the remotes to respond?
32) Why aren't the remote boxes changing color when I'm testing the remotes in
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the test screen?
33) One of my Q3 IR remotes lights up as a different number than what is labeled

on the remote.  How can I change the number?
34) What is assign fixed numbers and how do I do it?
35) What is the difference between Assign Fixed Numbers and Renumber buttons

in the Remote Options window?
36) My RF remotes says "No Host Found" or "No Net."  What do I do?
37) I received more remotes.  How will the program know that I have more

remotes?
38) How do I set the timer for the presentation?
39) I don't want to use the timer, how do I turn it off?
40) During presentation, how do I toggle between the question and answer

slides using the instructor remote?
41) Only 15/16 remotes show up at the bottom of the screen during presentation.

I have more than 15/16 remotes, why aren't all of my remotes showing up?
42) During presentation, how do I know which students have responded and

which haven't?
43) Can I display the student responses after they answer?  How do I display their

results?
44) Why can't I see all the remote numbers at the bottom of the screen during

presentation?
45) I want to give two different versions of a test to discourage cheating. Can I

present both versions at the same time using Interact?
46) How do students change their answer?
47) Using an instructor remote during presentation, how do I toggle between the

question and answer slides?
48) Using an instructor remote during presentation, how do I go to the next slide

or go back to the previous slide?
49) How do I pose a spontaneous question using the instructor remote?
50) In the Remote Assignments screen, the session ID is not appearing.  I can see

the word "session" but there isn't a number.  What's going on?
51) In the Assign Fixed Numbers screen, the Save button is missing.  How do I get

my Save button to appear?
52) My activities are printing weird characters.  How do I get the activities to print

out normal?
53) Are there software updates available online?

If you need technical assistance, contact us.  Please provide the following questions below
as we will need this information when you call:

· What operating system you are working on (Windows/Mac)?
· How long have you had your Qwizdom product?
· Where is the problem occurring?
· If you are getting an error, what does it say?  When an error occurs, it is
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helpful to write down what it says.

Website www.qwizdom.com

Phone (253) 770-1285

E-mail support@qwizdom.com

Office Hours 6:00 a.m. to 4:30 p.m. PST

Address Qwizdom, Inc.
12617 Meridian East
Puyallup, WA  98373

1)  What do I do if I am being prompted to type in my username and password,
but it's not working OR I don't have one?
Please contact Tech Support at 253-770-1285 to receive help to log into Qwizdom
Interact.

2)  When I launch Qwizdom Interact, it says that I have a certain number of days
before my trial period ends.  Why am I receiving that prompt if I purchased
the software?
If you've purchased the software and are receiving that prompt, you haven't
registered the software.

3)  How do I register Qwizdom Interact?
To register Qwizdom Interact, go to the Help menu and select Register Qwizdom
Interact.  You do not need to be connected to the internet to register.  Fill out your
information, enter the product code (located on the back of the software case),
and click on Activate.

4)  Does my computer need internet connection to register?
No, you do not need to have internet connection to register.

5)  Why is it saying "Invalid code" when I enter the product code?
If you enter the product code incorrectly, it will say it's an invalid code.  The letters
i, o, and numbers 1, 0 are a bit tricky to read.  The letter i will be a straight line ( I ),
the letter o will be a perfect circle ( O ), the number 1 will be a straight line with a
slant going down to the left, and the number zero will be a skinny circle ( 0 ).

6)  Why am I getting a prompt that says "You are missing the license(s) to the
following Curriculum..."?
The reason you are getting that prompt is because you need to register the
content.  When you first install the curriculum, you have to enter th e product code

http://www.qwizdom.com/index2.php
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for the software to know which curriculum units you have purchased.  This is not
registration.

7)  How do I register content?
To register, open Qwizdom Interact. Go to the Help menu and select Register
Content.  The Content Manager window will appear.  Enter the product code
(located on the back of the software case), click on Add and then Done.  The name
of the curriculum will appear in the Content Manager window.

8)  Why is there a "0" or negative number (in the Content Manager window) rather
than showing the name of the curriculum I registered?
The product code was entered in wrong.  Delete the incorrect entry and correctly
re-enter the product code.  The letters i, o, and numbers 1, 0 are a bit tricky to read.
The letter i will be a straight line ( I ), the letter o will be a perfect circle ( O ), the
number 1 will be a straight line with a slant going down to the left, and the
number zero will be a skinny circle ( 0 ).

9)  Why is the Present button grayed out when I try to present an activity?
The Present button is grayed out because you are attempting to present
unregistered curriculum.  You need to register the curriculum before presenting it.

10)  How do I import Qwizdom TA resources into Qwizdom Interact?
When you open Qwizdom Interact, it will automatically detect if there are any
Qwizdom Teaching Assistant resources on your computer.  The Show TA Convert
Form window will appear if there are any Qwizdom Teaching Assistant Resources
detected.  Check the resources you would like to convert into Qwizdom Interact
and click on Convert.  This process may take a few minutes to import, depending
on the file size.  If you are having problems converting the resources, please call
Tech Support at 253-770-1285.

11)  I converted the Qwizdom TA resources into Qwizdom Interact but the images
are missing.  How do I get the images to appear?
The images folder in the Qwizdom Teaching Assistant folder needs to be copied
into the Qwizdom Interact folder.

1. Right click on the Qwizdom TA icon, select Properties, click on the Shortcut tab,
and click on the Find Target button.  This opens the Qwizdom TA folder.  Set
this window aside and go back to the desktop.

2. Right click on the Qwizdom Interact icon, select Properties, click on the
Shortcut tab, and click on the Find Target button.  This opens the Qwizdom
Interact folder window.

3. Now, go back to the Qwizdom TA folder window and click on the images
folder.

4. Drag and drop the images folder into the Qwizdom Interact folder.  Be sure
not to drop it into another folder.  There is an existing images folder in the
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Qwizdom Interact folder so you will be prompted "This folder already contains
a folder named images."

5. Click on the Yes to All button.  After the images have completed copying over
to the Qwizdom Interact folder, close out the windows and open Qwizdom
Interact.  All your images that were missing before, should now appear.

12)  How do I export activities that I've created or imported into Qwizdom
Interact?
Select the activity and go to the File menu.  Select Export Activity and save the
activity in the desired location.

13)  How do I import activities that I've exported from other computers with
Qwizdom Interact?
First, you must export the activity and save the file onto a disc, drop it into an
email, etc. to get it to the other computer.  When you're at the other computer
with your exported file, open Interact and go to the File menu and select Import
Activity or Archive.  The activity will import into Qwizdom Interact.

14)  I created slides at home, how do I get those slides into Qwizdom Interact on
my computer at school?
On your home computer, open Qwizdom Interact and select the activity you want
to export.  Go to the File menu and select Export Activity.  Save the exported activity
and drop it onto a disc, email, flash drive, etc.  On the computer at school, open
Qwizdom Interact and go to the File menu and select Import Activity or Archive.
Direct the path to the location of the exported file (disc, flash drive, etc.)  Click on
Open and the activity will import into the Qwizdom Interact.

15)  How do I save in Qwizdom Interact?
The program automatically saves things you create, install, grade, etc.

16)  I can't edit my slides anymore; most of my options are grayed out.  What
happened?
It sounds like your activity has been locked. Look at the activity name in the
content tree. You will see a small lock symbol on it. If you have presented an
activity and recorded scores, the activity will automatically become locked. This is
because the grades in the grade book are tied to the way that the activity
appeared when it was presented. If it becomes altered after recording scores, then
the reports become invalid.  The activity becomes locked to keep consistency in
the grade book.

17)  How do I unlock an activity?
There are two different choices.

1. You can select the activity in the content tree, go to the File menu, and select
Unlock. This will permanently remove the grades/responses that were
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recorded for the activity from the grade book.
2. You can duplicate the activity. Select the activity in the content tree, go to the

File menu, and select Duplicate As.  Type in the name of the duplicated
activity and click on OK.  This option leaves the previously recorded data in
the grade book. This is the best choice if you want to compare scores of an
activity taken more than once by a group, or if you want to present the same
activity to two different groups (with a slight change or two in the activity).

18)  How do I backup the work I've done within Qwizdom Interact?
Go to the File menu and select Backup Database.  It is best to backup your database
every day or once a week so if anything ever happens to your database, you will
always have a backup.

19)  How do I restore my Qwizdom Interact to an earlier date?
1. Go to the File menu and select Restore Database.  The Browse for Folder

window will appear.
2. The Backups folder should already be selected.  Double click on the Backups

folder and select the date you want to restore Qwizdom Interact to.
3. Click OK and exit out of Qwizdom Interact to restore the database to the date

you specified.

20)  How do I move my Qwizdom TA classes into Qwizdom Interact?
1. First, you will need to export the class lists from Qwizdom TA.  Open Qwizdom

TA and click on the Students button.
2. Double-click on the class you want to export.
3. Go to the File menu and select Export.  A prompt will appear asking you what

you would like to export.
4. Select Students.  The Export Students window will appear.
5. Select the fields you want to export.  Do not select fields that are blank for

this may cause some difficulties in importing.
6. Click on Export and save the class list.
7. Open Qwizdom Interact and click on the Students tab.
8. Go to the Class menu and select New Class.
9. Enter the name of the class and click Done.
10. Go to the File menu and select Import Students.  The Open window will

appear for you to search and select the class file.
11. Click on Import and the Student Import window.  Match the fields on the

right with the imported.  If the information on the left are headers, check the
"First Record is Header" box.  If the information on the right displays student
information, uncheck the "First Record is Header" box.

12. Click on Import and the class list will appear in the grade book.

21)  How do I import my class lists into Qwizdom Interact?
For .txt (tab delimited) or .csv (comma-delimited) class lists:
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1. Open Qwizdom Interact and click on the Students tab.
2. Go to the Class menu and select New Class.
3. Select the teacher and type in the name of the class.
4. Click Done when finished.
5. Now go to the File menu and select Import Students.  The Open window will

appear.
6. Search and choose the class you want to import.
7. Click on Open and the Student Import window will open.
8. Match the fields on the right with the imported information on the left.  If the

fields on the left are headers (First Name, Last Name, Remote Number, etc.),
check the box that says "First Record is Header."  If the fields on the left are
actual student information (Greg Myers, 10), uncheck the box that says "First
Record is Header."

9. Click on Import and the students will appear in the class.

22)  How do I export my class lists that I've created in Microsoft Excel or another
program so that I can import them into Qwizdom Interact?
If the program you are using can export .csv files (comma-delimited), then you will
be able to import the students into Qwizdom Interact.  You should be able to save
the class lists as .csv files using the save or export function if the program you're
using supports .csv.  Open Microsoft Excel and save the class list as a .csv file.  Now
you will be able to import the class list into Qwizdom Interact.

23)  Why am I getting a message that says "Invalid Lines" when I try to import my
class list into Qwizdom Interact?
You will get this message when the fields in the class list aren't separated correctly.
Each field like last name, first name, etc., needs to be separated by quotation marks
and commas.  You will need to open the file to check if the fields in the class file are
separated correctly.  If the file you're trying to import is a .csv file, right click on the
file and select Open With Notepad.  The file will open as a text document for you to
edit.  Edit the fields by placing quotation marks around each field and then
separating those fields with quotation marks by a commas.  There shouldn't be a
comma after the last field in the line.  So if you only have three fields on each line,
it should look something like this "Last Name", "First Name", "Remote Number"

24)  In the Remote Options window, how do I know if I should use Classroom set or
Roaming or Student Owned mode?

· Classroom set mode should be used if the same group of remotes will always
be used with the same host (receiver). This scenario is most common in K-12
settings. If you are going to share the set of remotes, you can still use this
mode as long as the remotes always stay with the same host. The remotes
are assigned a fixed number and the session ID is permanently assigned to
the remotes. Students may still log in using their student ID/user ID if you
select the option in the Presentation Setup window. This option allows the
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student to pick up any remote rather than having to use the same remote
each time.

· Roaming or Student Owned mode is best suited to university settings or
situations where the students will keep possession of the remotes and may
be in several classes where different hosts are used.  In this mode, the
students must have a numerical student ID/user ID to put into the remote.
Each time the remote is used, a new session ID has to be entered into the
remote.

25)  What is a session ID and where do I find it?
A session ID is used to identify which host (receiver) your remotes will be sending
information to. If you are using Classroom set mode, the session ID will be six digits
long.  There are a few ways to find what the host's session ID is-there may be a
sticker with the session ID on the bottom of the host, click on the Remotes button
and the session ID will be in the title bar of the Remote Options window, and click
on the Toggle button during presentation to display the session ID at the top of the
screen.  The Toggle button is the square image next to the Close (X) button.  You
can also press the Send key on the instructor remote to toggle the screen to show
the session ID at the top of the screen.
If you are using Roaming or Student Owned, the session ID will be four digits long.
The session ID can be found on the Remote Assignments screen during
presentation.

26)  When do I need to change my session ID and how do I do this?
Note: Q3 IR remotes do not require session IDs.
For Q4 remotes:  If your remote says "No Net," the session ID for the remote may
be incorrect. Choose the appropriate instructions from the following.
Note: Q3 IR remotes do not require session IDs.
For Q4 remotes:  If your remote says "No Net," the session ID for the remote may
be incorrect. Choose the appropriate instructions from the following.

1. Press the Menu key.
2. Use the right arrow key to scroll to Sess. ID.
3. Press the Send (double arrows) key to select it.
4. An existing session ID may appear and then the remote will ask if you want to

change it.
5. Press T/Yes key and then enter the correct session ID.
6. Press the Send (double arrows) key to confirm.

For Q5 remotes:  When the remote says "Session ID: XXXX Not found," the wrong
session ID has been put into the remote and you need to put in the correct session
ID. Choose the appropriate instructions from the following.

1. Press the Menu key. You can only press the Menu key if the remote says "No
Host Found."

2. Use the arrows on the thumb pad to scroll to Session. ID.
3. Press the Circle (middle in thumb pad) key to select it.
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4. Enter the correct session ID.
5. Press the Send (double arrows) key to confirm.

27)  I have an RF remote and entered in the wrong session ID.  How do I change
the session ID?

· For Q4 remotes, press the menu key and use the left/right arrows to find Enter
Session.  Press the Send key (double arrow) to confirm your selection.  Key in
the session ID and press the Send key (double arrow).

· For Q5 remotes, press the menu key and use the arrows on the thumb pad to
move through the selections.  Select Enter Session ID and press the center key
(in the thumb pad) or press the Send key (double arrow) to confirm your
selection.  Key in the session ID and press the Send key (double arrow).

28)  I am receiving an error that says "There is a problem with the base..."  What do I
need to do to get my host to initialize?
It may be that the USB Drivers weren't installed.  Refer to Installing the USB Drivers
for installation directions.

29)  How do I get the green light to come on the host?
Check the USB cable to make sure it's plugged in correctly.  The green light should
appear when the drivers are installed and the host is working correctly.  If you've
installed the drivers and checked the COM number the host is on, try switching the
USB cable to see if the cable is bad.

30)  The green light on the host is on, but the host still won't initialize.  What do I
do?
The COM number the host is on may not be correct.

1. Go to the Start menu and open the Control Panel.
2. Double click on System and click on the Hardware tab.
3. Click on the Device Manager button.  The Device Manager window opens.
4. Open Ports and see what COM number the Qwizdom Remote Host or

Qwizdom USB Base is.  The COM number should be anywhere from 1-9.  If it's
higher than 9, then that's the reason why the host isn't initializing.

5. Right click on the Qwizdom Remote Host or Qwizdom USB Base and select
Properties.

6. Click on the Port Settings tab and click on the Advanced button.
7. Change the COM number in the upper-left corner of the window.  COM 1-9

may be in use.  Pick COM 5 or 6 to overwrite.  Normally, printers, mouse, etc.
take up COM 1-3.

8. After changing the COM number, click on OK.
9. Open Qwizdom Interact and test the host.

31)  My remotes are not responding.  How do I get the remotes to respond?
The host must initialize for the remotes to respond during test mode, assign fixed
numbers, and/or presentation.
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· Q3 IR remotes require two AA batteries.  There is a diagram in the area where
you place the batteries.  It shows that the left battery goes in negative up,
positive down and the battery on the right goes in positive up, negative
down.  It may not seem like the batteries go in that way because of the
springs are on one side but they do.  The remotes only respond in the test
screen or presentation.

· Q4 RF remotes require two AA batteries.  The session ID needs to be entered
in the remote.  The session ID is found in a few places; on the bottom of the
RF host, in the title bar of the Remote Options window, and in the title bar of
the presentation (click on the square button next to the X button to show the
menu bar at the top of the window).  After entering the session ID, the
remotes only respond in the test/assign fixed numbers screen and
presentation.

· Q5 RF remotes have rechargeable batteries.  The remotes must be charged
for 24 hours.  The session ID needs to be entered in the remote.  The session
ID is found in a few places; on the bottom of the RF host, in the title bar of the
Remote Options window, and in the title bar of the presentation (click on the
square button next to the X button to show the menu bar at the top of the
window).  After entering the session ID, the remotes only respond in the
test/assign fixed numbers screen and presentation.

32)  Why aren't the remote boxes changing color when I'm testing the remotes in
the test screen?
For the Q3 IR remotes, be sure the batteries are in correctly.  For the RF remotes, be
sure that the remotes have the correct session IDs and that they have been
assigned fixed numbers.

33)  One of my Q3 IR remotes lights up as a different number than what is labeled
on the remote.  How can I change the number?
You are able to reprogram the remote using the software.

1. Right-click on the Qwizdom Interact icon on the desktop and select Properties.
2. Click on the Shortcut tab and click on the Find Target button.  This opens the

Qwizdom Interact folder window.
3. Double-click on "RmtTest.exe."  The Qwizdom Remote Tester window will

appear.
4. Enter the number of the remote in the # field and select 256 as the remote

type.  Be sure to put away the other remotes so that they aren't accidentally
reprogrammed.

5. Press any key on the remote and the key you pressed will light up on screen.
When you see the key you pressed change color, that indicates that the
remote has been reprogrammed.

34)  What is assign fixed numbers and how do I do it?
Assign fixed numbers is where you assign the remote numbers for the RF remotes.
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Click on the Remotes button and the Remote Options window will open.

35)  What is the difference between Assign Fixed Numbers and Renumber buttons
in the Remote Options window?
Assign fixed numbers is where the remote is assigned a number.  Renumbering
does not affect the hardware.  It affects the remote numbers in the class.
Renumbering renumbers the student remotes in the class, it does not affect the
actual remotes.  This feature renumbers the remotes in numeric order in
alphabetic order.  This comes in handy when the remote numbers in the class are
offset.  You can renumber the current class or all classes.

36)  My RF remotes says "No Host Found" or "No Net."  What do I do?
If the RF remote says "No Net," it could be that the session ID has been entered
incorrectly.

1. To change the session ID, wait for the remote to say "No Net."
2. Press the Menu key when the remote says "No Net."
3. Use the arrows to scroll to Enter Session ID or Sess. ID.
4. Press the Send (double arrows) key to select the option.  For the Q4 remotes,

the remotes will display the current session ID and will ask if you would like
to change the ID.  Press T (Yes) to change the session ID.

5. Enter the session ID and press the Send (double arrows) key.

37)  I received more remotes.  How will the program know that I have more
remotes?
You will need to change the lowest/highest number settings in Remote Options.  In
the Content or Student screen, click on the Remotes button.  This is Remote
Options.  Set the lowest number as 1 (or the lowest number remote you have) and
set the highest number as the last number remote you have (e.g. 24).  Click on
Done to save changes.

38)  How do I set the timer for the presentation?
There are two ways to set the timer-within each slide set or the Presentation Setup
window.  To set the timer in the slides, double-click on a slide.  On the Properties
tab, type in the number of seconds you want the slide to display for in the
TimeLimit box.  Slide times can vary.  After you set the time for all the slides, click
on the Present button.  The Presentation Setup window will appear.  If you want to
use the time set in each slide of the activity, check the "Use Time from Each
Question" option under the 4 Play Options box.
You can also set the timer in the Presentation Setup window.  In the 4 Play Options
box, select the option to enter in the number of seconds that you want each slide
to be displayed for.  This timer will apply for all the slides so that all the slides will
have the same time limit.

39)  I don't want to use the timer, how do I turn it off?
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The only time the timer applies to the presentation is during games and
presentations on auto-pilot loop.  There isn't a way to turn the timer off.  If you are
not playing a game or using auto-pilot loop, the instructor must advance the slides
using the instructor remote or the mouse.

40)  During presentation, how do I toggle between the question and answer
slides using the instructor remote?
You can toggle between the question/answer/information slides within a slide set
by using the up and down arrows on the thumb pad of the remote.

41)  Only 15/16 remotes show up at the bottom of the screen during presentation.
I have more than 15/16 remotes, why aren't all of my remotes showing up?
Be sure you loaded the correct class.  If you only see 15 remotes at the bottom, it
sounds like you may have selected Period1 as the class, which is our default class
that has 15 students.  If you only see 16 remotes, chances are that you're playing a
game.  If that's the case, some games have limits on the number of players.  Refer
to the Games section to see how many players can participate in each game.  Also,
check the number of remotes you have set up in Remote Options.  In the Content or
Students screen, click on the Remotes button.  This is Remote Options.  Set the
lowest number as 1 (or the lowest number remote you have) and set the highest
number as the last number remote you have (e.g. 24).  Click on Done to save
changes.

42)  During presentation, how do I know which students have responded and
which haven't?
The buzz-in bar, at the bottom of the presentation, shows the remote numbers in
the class.  Every remote number box is gray until a student send in their answer.
When a student send in their answer, their remote number box will change color.
The colors do not indicate if the student got the answer incorrect/correct, or if
their response was first.  Remote number boxes that are still gray, means that the
student with that remote number has not yet responded.

43)  Can I display the student responses after they answer?  How do I display their
results?
Yes, you can display the results by showing the response graph.  There are four
different ways to show the results-bar, pie, scatter, and individual response.

· IR remotes- using the instructor remote, press the Delta (triangle) key to
display the response graph. Press the Delta (triangle) key again to close the
response graph.  Use the slash key (>) to scroll through the different graphs.

· RF remotes- using the instructor remote, press the slash (bar graph arrow)
key to display the response graph.  Press it again to close the response graph.
Use the left and right arrows on the thumb pad to scroll through the different
graphs.

The keypad short cut to display graph is Ctrl+G.
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44)  Why can't I see all the remote numbers at the bottom of the screen during
presentation?
There are a few reasons why this may occur:

· A lesson or non-remote answerable slide is being presented.
· Remotes cannot be used during a lesson presentation.  The slides must be

remote-answerable as well.  If the question type is essay, fill-in-the-blank, you
will not be able to use remotes.  Also, if the slides do not have answer slides,
the remotes will not be able to respond.

The Windows taskbar may be covering the remote boxes:
Right-click on the taskbar and select Properties. In the Taskbar tab, select the

"Auto-hide the taskbar" option and click OK.
The correct class wasn't loaded:

· If you select a class that only has 15 students, only 15 remote boxes will
appear at the bottom of the screen.

Playing a game:
· Certain games limit the number of players. See the games section in the user

guide for more information.
· Remote Lowest/Highest Numbers haven't been set.
· Click on the Remotes button and check the Lowest/Highest Numbers. The

lowest number is the first remote number in your set (usually that is 1) and
the highest number is the last remote number in your set (e.g. 32).

45)  I want to give two different versions of a test to discourage cheating. Can I
present both versions at the same time using Interact?
Yes, you can do this by presenting multiple answer keys.

1. Create the answer keys for each version you want to present to the class.
2. After the answer keys have been created, select one of the answer keys in the

content tree.  The test number for the answer key will appear in the title bar
at the top of the screen.

3. Write the number down and then select the other answer key to get the test
number for these numbers are needed for the presentation.

4. Print and pass out the paper version of the tests to the students.
5. Click on the drop-down menu on the Present button and select Present

Multiple Answer Keys.  The Presentation Setup window appear.
6. Select the correct class and click OK.  The remotes will prompt the students to

enter an activity ID.  The activity ID is the test number you wrote down from
the answer keys.

7. Have students enter in their activity ID number and press the Send (double
arrow) key.  By entering in the activity ID (test number), the remote will
recognize which test the student is taking and it will display the proper
answer choices based on the answer key that you created.

Students scroll between questions by using the left/right arrow keys. The question
# that they are on is visible in the upper left corner of the remote. The computer
screen will display the remote numbers with a box next to it that will say "-" if the
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student hasn't started taking the test yet, "IP" if the test is in progress, and "+"
when the student has completed the test.

46)  How do students change their answer?
In the Presentation Setup window, make sure the Right/Wrong Feedback is disabled.
This way, students will not know if their response is correct or incorrect. Also,
uncheck the "One Response Per Remote" option.
If presenting an answer key:

1. A prompt will appear asking if you want students to be allowed to change
their answers.

2. Click Yes to allow students to change their answers.
To change answers using Q3 IR remotes:

1. Press the Delta (triangle) key on the student remote.
2. Press the number of the question you want to go back to and press the Send

key.  The question number the student requested to go back to will appear
next to the student's remote number. The boxes will highlight in red.  The
student will now be able to change the answer and press the Send key to
submit the new answer.

3. After the answer is changed, the next consecutive question will appear next
to their remote number.

To change answers using Q4/Q5  RF remotes:
1. Use the left arrow to go back to a previous question.
2. When the question number of the answer you want to change appears on

the remote (in the upper right   corner), press the C (Clear) key to delete the
previous answer.

3. Enter in the new answer and press the Send key.
When you are finished changing your answers, press the right arrow key until the
remote asks if you are done.  If you have completed the test, press Yes; if you have
not completed the test, press No.  Once you press Yes, you cannot go back so be
sure everything is correct.

47)  Using an instructor remote during presentation, how do I toggle between the
question and answer slides?
You can toggle between the question/answer/information slides within a slide set
by using the up and down arrows on the thumb pad of the remote.

48)  Using an instructor remote during presentation, how do I go to the next slide
or go back to the previous slide?
Use left/right arrows on the thumb pad to scroll through the slides.

49)  How do I pose a spontaneous question using the instructor remote?
· For IR-During presentation, press the ? key, key in the answer (letter or

numeric), followed by the Send key (double arrows).  A question mark icon
will appear on the screen.  This lets students know to press the Send key
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(double arrows) after they've entered their response.
· For RF-The instructor remote must be version .64 or higher.  During

presentation, press the dash key (New Q) and the question types will appear
on the instructor remote.  Using the up/down arrows on the thumb pad,
select the question type you'd like to pose, and press the Send key (double
arrows).  The choices for the question type you selected will appear on the
instructor remote.  Select the answer and press the Send key (double arrows).
If you choose to not have an answer, press the Send key (double arrows)
without selecting an answer for it to be recognized as a survey type question.

50)  In the Remote Assignments screen, the session ID is not appearing.  I can see
the word "session" but there isn't a number.  What's going on?
It may be that the screen resolution is too large.

1. Go into the Control Panel and double-click on Display.
2. Click on the Resolution tab and change the screen resolution.
3. Click on OK and the session ID should now appear in the Remotes

Assignments screen.

51)  In the Assign Fixed Numbers screen, the Save button is missing.  How do I get
my Save button to appear?
It sounds like the DPI setting on your computer is too large.

1. Go into the Control Panel and double-click on Display.
2. Click on the Resolution tab and click on the Advanced button.
3. Click on the General tab and change the DPI setting to Normal (96).

52)  My activities are printing weird characters.  How do I get the activities to print
out normal?
If activities or reports are printing with overlapping fonts/characters and is
completely ineligible, the problem is a printer driver issue.  Each printer driver
issue will have different directions because of the brand.  The directions below are
for Brother printers.

1. Go to the Control Panel double-click on Printers and Faxes.
2. Find your default printed and right click on the printer and select Properties.
3. Click on the Advanced tab and then click on the Printing Defaults button.
4. Click on the Advanced tab and then click on the button that has the image of

the tool wrench on it.
5. In the column on the right, select Print Setting.
6. Uncheck "Use Printer TrueType Fonts" box.
7.    Click on OK to apply and close the remaining open windows.

53)  Are there software updates available online?
Updates are available online for existing customers at
http://www.qwizdom.com/downloads.htm.  Updates are not full versions of the
software.  You must have existing software installed onto your computer before

http://www.qwizdom.com/downloads.htm
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installing the latest update.  If you have Qwizdom TA and are trying to install the
Qwizdom Interact update, it will not work.  If you do not have any version of our
software installed, you cannot install the update because it isn't the full version of
the software.  To get the full version of the software, call 800-347-3050 to get
information on purchasing.

8.4 Glossary

Activity-contains slide sets that are presented as lessons, tests, games, etc.
Anonymous Class-anonymous users are generated by the entered number of remotes to
create an anonymous class.
Answer Key-paper based activity that only requires the question type with correct answer,
points, and time; student works off a paper and answers with the remote.

Categories-are how the slides are organized for the Quandary game; 5 categories
represents the 5 columns to choose from.
Classroom Set-when the hardware (remotes and host) are used in the same room; this
mode is best suited for K-12 and corporate settings.
Content-materials such as activities and folders created in the Content screen.
Content screen-screen where the content tree and slides are managed and stored;

considered the main screen.
Content Tree-column located on the left side of the Content screen where all activities

and folders are managed and stored.
Curriculum-subject materials such as Science, Math, History, etc.

Database-where grade book, classes, students, and activity names are saved and stored.
Difficulty-difficulty of question slide; can be set as Simple, Intermediate, Advanced, and
Expert.

Equation Editor-where equations are created to insert onto the slide.
Essay-question type; teacher can print out the essay slides on paper for students to
answer.

Fill In Completion-question type; alphanumeric input can be entered using the Q5 RF
remote (only).
First Record is Header-when importing a class list, if the first record shows headers such
as "First Name," "Last Name," "Student ID," etc., then the box needs to be checked.  If there
is actual information showing as the first record, then the First Record is Header box is
unchecked.
Folder-contains and organizes activities.

Grade Book-manages classes, students, and grades; located in Students screen.
Grade Scales-grade scales can be created and customized to suit the grading system that
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best fits the class requirements.

Host-is the round, disc-shaped USB device that plugs into the computer to communicate
with the remotes to collect and send data.

Information-question type; non-remote answerable slide.  Only one slide per slide set is
allowed for lessons.
IR-infrared

Layout-is where you select a template from.
Locking-a graded activity becomes locked so that the slides within the activity cannot be
edited to prevent grade alteration.

Master List-where all created and imported students are stored.
Multimedia-images, sound, or movie files
Multiple Answer List-question type; more than one multiple choice is the answer in a list
form.
Multiple Choice-students select A-F choices for the correct answer by remote (or paper).
Multiple Mark-students are able to select more than one choice for the answer; eliminates
having to choose E or F for "all of the above responses."

Narration-computer generated voice that reads the slides out loud during presentation.
New Set-a slide set
Numeric Problem-question type; students answer by remote (or paper) by keying in the
answer and hitting the Send key on the remote.

Points-value; points determine score.
Product Code-16 character code that is used to register and install software
Product Key-see Product Code

Q3 IR-Blue 19 button remotes; infrared
Q4 RF-Red/Gray small LCD remotes; radio frequency
Q5 RF-Red/Gray large LCD remotes that allows alphanumeric input; radio frequency

Rating Scale-question type; students answer a rating scale question by remote (i.e. on a
scale from 1-7, how would you rate this?)
Remotes-interactive hand held devices
Response graph-displays results of question during presentation mode
RF-radio frequency
Roaming or Student Owned-student owns the remote or remote goes with the student
to different classes to use with a different host and session ID

Sequence-question type; students answer by remote (or paper) in sequence (i.e. What
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order do these go in?)
Session ID-this is the unique host ID number that the remotes need to communicate with
the host; session IDs are entered into the remote so that the remote knows which host to
send the information to.
Short Answer Specific-question type; alphanumeric input can be entered using the Q5 RF
remote (only).
Slides-displays information, images, sound, and animations for presentation purposes.
Slide Editor-screen where slides are created.
Slide Set-a slide set holds up to five individual slides; normally contains two slides which
are the question and answer slides or one slide as an information slide.
Spontaneous Survey Bar-free floating bar that can be used in other programs and still be

able to collect data from remotes.
Standards-state standardized objectives
Students screen-screen where grade book, classes, and students are managed
Student ID-student ID is a unique ID for students (IDs can only numeric); students IDs are

required when logging in with remotes into a presentation.
Student Mode-individual works within the program on assignments that the teacher
assigns (on the computer).  This is one-on-one learning mode for students to work at their
own pace and make up missed assignments, tests, etc.

Template-used to organize information such as text and multimedia on a slide; located in
Layouts.
Time Limit-time set for students to answer the question.
True or False-question type; students answer by remote (or paper) T for true or F for false.
Type-is the format of the slide; i.e. Information, Multiple Choice, True/False, Short Answer,
etc.

Unlocking-removes the lock from an activity and deletes any scores attached to that
activity.

User ID-see Student ID

Yes or No-question type; students answer by remote (or paper) T for yes or F for no.
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